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Preface
Thank you for purchasing the DocuPrint CP305 d.
This guide is intended for users who use the printer for the first time, and provides all the necessary 
operating information about the printer function.
Please read this guide to achieve the best performance from this printer.
This guide assumes you are familiar with computers and the basics of network operation and 
configuration.
After reading this guide, keep it safe and handy for future reference.

DocuPrint CP305 d User Guide Help

Copyright© 2011 by Fuji Xerox Co., Ltd.

Fuji Xerox Co., Ltd.

January 2011 (Edition 1)

ME5055E2-1
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Trademarks and Document Disclaimer
Apple®, Bonjour®, ColorSync®, Macintosh®, and Mac OS® are trademarks of Apple Inc. in the United 
States and/or other countries.
PCL® is a trademark of Hewlett-Packard Corporation in the United States and/or other countries.
Microsoft®, Windows Vista®, Windows®, and Windows Server® are trademarks of 
Microsoft Corporation in the United States and/or other countries.
Linux is a registered trademark of Linus Torvalds.
Novell is a registered trademark and SUSE is a trademark of Novell, Inc. in the United States and 
other countries.
Red Hat and Red Hat Enterprise Linux are registered trademarks of Red Hat, Inc. in the U.S. and 
other countries.
All product/brand names are trademarks or registered trademarks of the respective holders.

XEROX, the sphere of connectivity design, and DocuPrint are trademarks or registered trademarks of 
Xerox Corporation in the U.S. or Fuji Xerox Co., Ltd. 
All Xerox and Fuji Xerox product names are either registered trademarks or trademarks of Xerox 
Corporation or Fuji Xerox Co., Ltd.

In this manual, safety instructions are preceded by the symbol . Always read and follow the instructions 
before performing the required procedures.

It may be a legal offence to print currency notes, certificates of stocks and securities, or any other documents of 
similar nature, regardless of whether they will be used.

Fuji Xerox is not responsible for any breakdown of machines due to infection of computer virus or computer 
hacking.

IMPORTANT: 
1. This manual is copyrighted with all rights reserved. Under the copyright laws, this manual may not be copied 

or modified in whole or part, without the written consent of the publisher.

2. Parts of this manual are subject to change without prior notice.

3. We welcome any comments on ambiguities, errors, omissions, or missing pages.

4. Never attempt any procedure on the machine that is not specifically described in this manual. Unauthorized 
operation can cause faults or accidents. Fuji Xerox is not liable for any problems resulting from unauthorized 
operation of the equipment.

5. Decompiling this manual is prohibited.

An export of this product is strictly controlled in accordance with Laws concerning Foreign Exchange and 
Foreign Trade of Japan and/or the export control regulations of the United States.
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About License

RSA BSAFE
RSA BSAFE software, produced by RSA Security Inc., has been installed on this printer.

DES
This product includes software developed by Eric Young.
(eay@mincom.oz.au)

AES
Copyright© 2003, Dr BrianGladman, Worcester, UK. All rights reserved. This product uses published 
AES software provided by Dr Brian Gladmanunder BSD licensing terms.

TIFF(libtiff)
LibTIFFCopyright© 1988-1997 SamLeffler
Copyright© 1991-1997 Silicon Graphics, Inc.

ICC Profile (Little cms)
LittlecmsCopyright© 1998-2004 Marti Maria

JPEG
Our printer software uses some of the codes defined by the Independent JPEG Group.
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Types of Manuals

Manuals included with the printer
The following manuals are provided with the DocuPrint CP305 d.

Manuals included with an optional accessory
The following manual is provided with the optional accessories (sold separately).

Safety Guide Describes the information you need to know before using the printer 
and to operate the printer safely.

Setup Guide Provides step-by-step instructions on how to set up your printer.

User Guide (CHM Help for 
Windows/HTML files for Mac 
OS X)

Describes how to get ready to print and set various features. It also 
covers the operator panel menus, troubleshooting tips, and 
maintenance information.

This guide is on the Driver CD Kit.

PostScript® User Guide Describes how to set up your printer as a PostScript® printer and the 
features that can be configured on your print driver.

This guide is on the PostScript Driver Library CD.

Installation Guide Optional accessories that require an installation at the customer's site 
are provided with an Installation Guide.
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Using This Guide
This section includes:

• "Organization" on page 12
• "Conventions" on page 13
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Organization
This guide is organized into the following chapters. The summary of each chapter is as follows:

1 Specifications Describes the printer specifications.

2 Basic Operation Describes the main components of the printer, the power saver mode, 
and the preparation of the printer to use.

3 Printer Management Software Describes the software available for the printer.

4 Network Basics Describes the basic information about how to connect the printer to 
your computer via the network or USB and how to install the print 
driver.

5 Printing Basics Describes the supported paper, how to load paper, and how to print 
data using various print features.

6 Using the Operator Panel 
Menus

Describes the setting items available on the operator panel, and their 
setup procedures.

7 Troubleshooting Describes the troubleshooting tips for printer problems such as paper 
jams.

8 Maintenance Describes how to clean the printer, how to replace consumables, and 
how to see the printer status.

9 Contacting Fuji Xerox Describes support information.
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Conventions
1 In this guide, personal computers and workstations are collectively called “computers”.

2 The following terms are used throughout this guide:

IMPORTANT: 
• Important information that must be read and followed.

NOTE: 
• Additional information that merits emphasis.

See also: 
• References within this guide.
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Safety Notes
Before using this product, read “Safety Notes” carefully for safety use.
This product and recommended supplies have been tested and found to comply with strict safety 
requirements including safety agency approvals and compliance with environmental standards. Follow 
the following instructions for safety use.

Follow all warning instructions marked on this product. The warning marks stand for the followings:

WARNING:
• Any unauthorized alteration including an addition of new functions or connection to external devices 

may not be covered by the product warranty. Contact your local Fuji Xerox representative for more 
information.

Used for item that if not followed strictly, can lead death or severe or 
fatal injuries and the possibility to do it is comparatively high.

Used for items that if not followed strictly, can lead to severe or fatal 
injuries.

Used for items that if not followed strictly, can cause injuries to user or 
damages to machine.

: A symbol for items to pay attention to when handling machine. 

Follow instructions carefully to use machine safely.

: A symbol for prohibited items. Follow instructions carefully to avoid 
any dangerous acts.

: A symbol for items that must be performed. Follow instructions 
carefully to carry out these essential tasks.

Caution Flammable Explodable Electric 
shock

Heated 
surface

Moving 
object

Pinched 
fingers

Prohibited No fire Do not touch Do not use in 
bathroom

Do not tear 
down

Keep away 
from wet

Never touch 
with wet hand

Instructions Unplug Ground/ 
Earth
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Electrical Safety

 WARNING
This product shall be operated by the power source as indicated on the product's data plate. Consult 
your local power company to check if your power source meets the requirements.

 CAUTION

WARNING:
• Connect this product to a protective earth circuit.

This product is supplied with a plug that has a protective earth pin. The plug fits only into an 
earthed electrical outlet. This is a safety feature. If the plug doesn't fit to the outlet, contact an 
electrician to replace the outlet to avoid risk of electric shock. Never use an earthed adapter 
plug to connect the product to the electrical outlet that has no earth connection terminal.

Improper connection of a grounding conductor may cause electric shock.

Plug the power cord directly into a grounded electrical outlet. To prevent overheat and a fire 
accident, do not use an extension cord, a multi-plug adaptor or a multiple connector. Consult 
your local Fuji Xerox representative to check if an outlet is grounded.

Connect this product to a branch circuit or an outlet that has larger capacity than the rated 
ampere and voltage of this product. See the data plate on the rear panel of this product for its 
rated ampere and voltage.

Never touch the power cord with wet hands. It may cause electric shock.

Do not place an object on the power cord.

Always keep the plug connection free of dust. The dusty and damp environment may bring 
about minute electric current in a connector. It may generate heat and eventually cause a fire 
accident.

To avoid the risk of electric shock and a fire accident, only use the power cord supplied with this 
product or the ones designated by Fuji Xerox.

The power cord is exclusive use for this product. Do not use it for any other product.

Do not damage or alter the power cord. Damage and alteration may generate heat and 
eventually cause electric shock or a fire accident.

If the power cord is damaged or insulated wires are exposed, contact your local Fuji Xerox 
representative for its replacement. Do not use a damaged or uninsulated cord to avoid the risk 
of electric shock and a fire accident.

When cleaning this product, always switch off and unplug it. Access to a live machine interior 
may cause electric shock.

When cleaning this product, switch off the product and its switchboard (branch circuit). Access 
to a live machine interior may cause electric shock.

Do not unplug or re-plug this product with the switch on. Plugging and unplugging a live 
connector may deform the plug and generate heat, and eventually cause a fire accident.
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Hold the plug not the cord when unplugging this product, or it may damage the cord and cause 
electric shock or a fire accident.

Always switch off and unplug the machine when it is not used over weekends or long holidays. 
It may cause deterioration of insulations and eventually electric shock or a fire accident.

Once a month, switch off this product and check if
• the power cord is plugged firmly into an electrical outlet;
• the plug is not excessively heated, rusted or bent;
• the plug and electrical outlet are free of dust; and
• the power cord is not cracked or worn down.

Once you notice any unusual condition, switch off and unplug this product first and contact your 
local Fuji Xerox representative.
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Machine Installation

 WARNING

 CAUTION

Do not locate this product where people might step on or trip over the power cord. Friction or 
excessive pressure may generate heat and eventually cause electric shock or a fire accident.

Never locate this product in the following places:
• Near radiators or any other heat sources
• Near volatile flammable materials such as curtains
• In the hot, humid, dusty or poorly ventilated environment
• In the place receiving direct sunlight
• Near cookers or humidifiers

This product weighs 19.8 kg *(the main unit with consumables)*. When moving it, always carry 
it by a team of two or more persons to avoid mishandling or injury.

Locate this product on a level and sturdy surface that can withstand 19.8 Kg. 

Otherwise, if tilted, the product may fall over and cause injuries.

Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the 
product. 

Keep the minimum clearance as follows for ventilation and an access to the power plug. 
Unplug the product if an abnormal condition is noted.

750 mm

616 mm

100 mm

200 mm

250 mm

600 mm 457 mm 50 mm

600 mm 457 mm 50 mm
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Do not incline the product at more than 10 degree angle. Otherwise, it may fall over and cause 
injuries.

To bundle wires and cables, always use the cable ties and spiral tubes that Fuji Xerox supplies. 
Otherwise, it may cause some defects.

10° 10°

10° 10°

Right Left Right Left

Front Rear Front Rear
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Operational Safety

 WARNING

 CAUTION

The operator's product maintenance procedures are described in the customer documentation 
supplied with this product. Do not carry out any other maintenance procedures not described in 
the documentation.

This product features safety design not to allow operators access to hazard areas. The hazard 
areas are isolated from operators by covers or protectors which require a tool to remove. To 
prevent electric shock and injuries, never remove those covers and protectors.

To avoid the risk of electric shock and a fire accident, switch off and unplug the product 
promptly in the following conditions, then contact your local Fuji Xerox representative.
• The product emits smoke or its surface is unusually hot.
• The product emits unusual noise or odor.
• The power cord is cracked or worn down.
• A circuit breaker, fuse or any other safety device is activated.
• Any liquid is spilled into the product.
• The product is soaked in water.
• Any part of the product is damaged.

Do not insert any object into slots or openings of this product.
Do not place any of the followings on the product:
• Liquid container such as flower vases or coffee cups
• Metal parts such as staples or clips
• Heavy objects

If liquid is spilled over or metal parts are slipped into the product, it may cause electric shock or 
a fire accident.

When cleaning this product, use the designated cleaning materials exclusive to it. Other 
cleaning materials may result in poor performance of the product. Never use aerosol cleaners, 
or it may catch fire and cause explosion.

Never play the CD-ROM supplied with the product on an audio player. Always use a CD-ROM 
player. Otherwise, large sound may damage audio players or your ears.

Laser Safety

Caution:
• Any operations or adjustments not stated in the operation manual may cause 

hazardous light exposure and eventually burn injuries or loss of eyesight.
This product has been tested and found to comply with the Class 1 Laser Equipment 
requirements defined by the international standard IEC60825 and has no light exposure 
hazard. The product has no hazardous light emission as it features light protection components 
and covers to shut in all light beam during operation and maintenance.

Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the “High 
Temperature” or “High Voltage” marks on.

Ventilate well during extended operation or mass copying. It may affect the office air 
environment due to odor such as ozone in a poorly ventilated room. Provide proper ventilation 
to ensure the comfortable and safe environment.
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Consumable

 WARNING

 CAUTION

Store all consumables in accordance with the instructions given on its package or container.

Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills. 
It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill 
a large volume of toner, contact your local Fuji Xerox representative.

Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch 
fire and cause burn injuries or explosion.

If you have a used toner cartridge no longer needed, contact your local Fuji Xerox 
representative for its disposal.

Keep drum cartridge and toner cartridges out of the reach of children. If a child accidentally 
swallows toner, spit it out, rinse mouth with water, drink water and consult a physician 
immediately.

When replacing drum cartridge and toner cartridges, be careful not to spill the toner. In case of 
any toner spills, avoid contact with clothes, skin, eyes and mouth as well as inhalation.

If toner spills onto your skin or clothing, wash it off with soap and water.

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes 
until irritation is gone. Consult a physician if necessary.

If you inhale toner particles, move to a fresh air location and rinse your mouth with water.

If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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Warning and Caution Labels
Be sure to follow the warning and caution labels placed on the machine. Do not touch areas with 
labels indicating high voltage or temperature. This can cause an electric shock or burn.

CAUTION:
• Always follow all warning instructions marked on or supplied with this product. To avoid the risk of 

burn injuries and electric shock, never touch the area with the "High Temperature" or "High Voltage" 
marks on.

PRODUCT CODE

*0000*

To ensure optimum quality and
performance of your printer, we
recommend only using genuine 
Fuji Xerox toner.   

BLACKK
[TYPE-  ]

Not for sale in Japan
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Environment
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 

cartridges and drum cartridge to make recycle parts, recycle materials or energy recovery.
• Proper disposal is required for toner cartridges and drum cartridge no longer needed. Do not 

open toner cartridges and drum cartridge containers. Return them to your local Fuji Xerox 
representative.
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Regulation

Radio Frequency Emissions (Class B)

NOTE: This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to CISPR Publ.22 and Radio communication Act 1992 in 
Australia/NewZealand. 

These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment and receiver.
– Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected.
– Consult the dealer or an experienced radio/TV technician for help.

Changes and modifications to this equipment not specifically approved by Fuji Xerox may void 
the user’s authority to operate this product.
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Illegal Copies and Printouts
Copying or printing certain documents may be illegal in your country. Penalties of fines or 
imprisonment may be imposed on those found guilty. The following are examples of items that may be 
illegal to copy or print in your country. 

• Currency
• Banknotes and checks
• Bank and government bonds and securities
• Passports and identification cards
• Copyright material or trademarks without the consent of the owner
• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel.
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Product Features
This section describes the product features and indicates their links.

2 Sided Print (Duplex Print)

2 Sided Print is to print two or more pages on 
the front and back side of a single sheet of 
paper. This feature allows you to reduce the 
paper consumption.

For more information, see "Duplex Printing" on 
page 124.

Using the Stored Print Function (Stored 
Print)

The Stored Print feature allows you to 
temporarily store your print data in the printer 
memory and output it later. You can effectively 
manage your time when you print confidential 
data or large-volume data at off-peak hours.

For more information, see "Using the Stored 
Print Function" on page 120.

Multiple-Up Print

Multiple-Up enables you to print multiple pages 
on a single sheet of paper. This feature allows 
you to reduce the paper consumption.

For more information, see the print driver's help.



Product Features 26



27 Specifications

1
Specifications

This chapter lists the main specifications of the printer. Note that the specifications of the product may 
change without prior notice.

Items Description
Product Code DocuPrint CP305 d

Type Console

Printing method Laser Xerography

IMPORTANT: 
• Laser + electrophotographic system

Fusing system Thermal fusing system

Warm-up Time 20 seconds or less (after powering on at 22 °C temperature) 

Continuous print speed*1 A4 plain paper

Color 1 Sided*2: 23 sheets/min; 2 Sided*3: 16 pages/min

Monochrome 1 Sided: 23 sheets/min; 2 Sided: 16 pages/min

IMPORTANT: 
*1 Print speed may decrease due to factors such as paper type, paper size, 

and printing conditions.
*2 When continuously printing a single document of A4 .
*3 A4  continuous printing

First print 15.5 seconds

IMPORTANT: 
• Measurements based on Fuji Xerox test pattern. Time from printer 

startup until output of the first page is complete. 

Resolution Output Resolution: 600 × 600 dpi

Tone/Color 256 tones/color (16.7 million colors)
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Paper Size A4, B5, A5, Legal (8.5 × 14"), Folio (8.5 × 13"), Letter (8.5 × 11"), 
Executive, Com-10, Monarch, DL, C5, Custom Paper (Width: 76.2 – 
215.9 mm, Length: 127 – 355.6 mm)

Image loss: 4.1 mm from the top, bottom, left, and right edges

Paper Type Plain Paper, Card Stock (Thin/Thick), Envelope, Labels 
(Normal/Thick), Letterhead, Glossy Paper (Normal/Thick), 
Pre-Punched, Colored Paper, Special

IMPORTANT: 
• Fuji Xerox P paper (64 g/m2) 
• Use only the recommended paper. Using paper other than that 

recommended for the printer can cause printing problems. Do not 
use special ink jet paper. 

• Note that poor printing quality due to paper-related printing 
problems can occur when using the printer in an environment that 
is dry, cold, or very humid. 

• Printing over the printed side or on the reverse side of paper that 
already has been printed on can result in poor print quality.

• When printing on envelopes, use envelopes that do not have 
adhesive applied.

• The type of paper being used and environmental conditions can 
affect printing quality. Because of this, it is recommended that you 
test print and confirm proper print quality before using the printer.

Paper capacity Standard:
Standard 250-sheet tray: 250 sheets
Optional 250-sheet feeder: 250 sheets
SSF: 1 sheet

IMPORTANT: 
• Fuji Xerox P paper (64 g/m2)

Output tray capacity Standard: approximately 150 sheets (face down)

IMPORTANT: 
• Fuji Xerox P paper (64 g/m2) 

2-sided Printing Feature Standard

CPU ARM11 400MHz

Memory capacity Standard: 256 MB (Onboard)

Maximum: 768 MB (Onboard256 MB + DIMM512 MB)

IMPORTANT: 
• The above memory capacity does not guarantee print quality 

depending on the type and content of print data. 

Hard disk —

Fonts Build-in fonts

PCL5 and PCL6 fonts: 81 fonts and 36 symbol sets

PostScript 3: 136 fonts

PDF Font: 14 fonts

Page Description Language PCL 5e, PCL 5c, PCL 6, PostScript 3, FX-PDF, HBPL

Items Description
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Supported OS Standard: PCL6 and PostScript drivers
Microsoft® Windows® 2000,
Microsoft® Windows® XP,
Microsoft® Windows Server® 2003,
Microsoft® Windows Server® 2008,
Microsoft® Windows Vista®,
Microsoft® Windows® 7,
Microsoft® Windows® XP x64,
Microsoft® Windows Server® 2003 x64,
Microsoft® Windows Server® 2008 x64,
Microsoft® Windows Vista® x64,
Microsoft® Windows Server® 2008 R2 x64,
Microsoft® Windows® 7 x64,
Mac OS® X 10.3 – 10.6,
Red Hat Enterprise Linux 4 WS/5 Client (x86),
SUSE Linux Enterprise Desktop 10/11 (x86)

IMPORTANT: 
• For information about the latest supported OS, contact our 

Customer Support Center.

Interface Standard: Ethernet (1000BASE-TX/100BASE-TX/10BASE-T), USB 
2.0

Supported protocol TCP/IP (LPD, Port9100, WSD, HTTP, SMTP, RARP, AutoIP, WINS, 
FTP, Telnet, DDNS, IPP, SMB), SNMP, DHCP, BOOTP, Bonjour 
(mDNS)

Power AC 110 - 127 V ± 10%; 10 A or less; both 50/60 Hz ± 3%

AC 220 - 240 V ± 10%; 5 A or less; both 50/60 Hz ± 3%

IMPORTANT: 
• Power outlets that provide the above power level is 

recommended. Maximum machine measured current: 12.5A

Operating noise

(main unit only)

During operation: 
color : 6.8 B; 53.5 dB (A)
monochrome : 6.8 B; 53.5 dB (A)

During stand-by: 4.3 B

IMPORTANT: 
• Measurements based on ISO7779

Unit B: acoustic power level (LwAd)
Unit dB (A): radiated sound pressure (bystander position)

Power consumption Maximum: 1100 W, During the Sleep mode: 8 W or less

Average: 
During standby: 60 W, 
During continuous color printing: 365 W, 
During continuous monochrome printing: 365 W

IMPORTANT: 
• Sleep Mode: 8 W average

(The printer does not use electricity when the power is switched 
off even with the power cord is plugged in.)

Items Description
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Dimensions (main unit only) 400 (W) x 460.9 (D) x 436.4 (H) mm

Weight Main Unit: 19.8 kg (main unit only, including consumables)

Usage Environment During Use: Temperature: 5 - 32 °C; Humidity: 10 - 85% (except 
malfunctions due to dew condensation)

Non-Use: Temperature: -20 - 40 °C; Humidity: 5 - 85% (except 
malfunctions due to dew condensation)

IMPORTANT: 
• Until the conditions (temperature and humidity) inside the printer 

become acclimated to the installation environment, certain 
qualities of the paper can cause poor printing. 

Items Description
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2
Basic Operation

This chapter includes:
• "Main Components" on page 32
• "Preparing Printer Hardware" on page 37
• "Installing Optional Accessories" on page 38
• "Turning on the Printer" on page 46
• "Printing a Panel Settings Page" on page 47
• "Power Saver Mode" on page 48
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Main Components
This section provides an overview of your DocuPrint CP305 d.
This section includes:

• "Front View" on page 33
• "Rear View" on page 34
• "Operator Panel" on page 35
• "Securing the Printer" on page 36
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Front View

1 Operator Panel 2 Front Cover

3 Single Sheet Feeder (SSF) 4 Width Guides

5 Standard 250-Sheet Tray 6 Optional 250-Sheet Feeder

7 Side Cover 8 Side Button

9 Output Tray 10 Output Tray Extension

11 Fuser Unit 12 Drum Cartridge

13 Belt Unit 14 Duplexer

15 Toner Cartridge

1

2

3

4
5

6

10

9

8

7

11

12
13

14

15
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Rear View

1 USB Port 2 Ethernet Port

3 Power Switch 4 Power Connector

5 Security Slot 6 Control Board Cover

1

2

6

5

34
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Operator Panel
The operator panel has a liquid crystal display (LCD) and buttons.

1 LCD Panel
• Displays various settings, instructions, and error messages. 

2 Menu button
• Moves to the top menu.

3   buttons
• Scrolls through menus or items in the Menu mode. To enter numbers or passwords, press 

these buttons.

4   buttons
• Selects submenus or setting values in the Menu mode.

5 Energy Saver button
• Lights up in the Sleep mode. Press this button to exit the Sleep mode.

6 Cancel Job button
• Cancels the current print job.

7  button
• Displays the selected menu or item and determines the selected value in the Menu mode.

8  (Back) button
• Switches to the Print mode from the top menu of the Menu mode.
• Returns to the upper hierarchy of the menu from the submenu of the Menu mode.

9 Error LED
• Lights up when the printer has an error.

10 Ready LED
• Lights up when the printer is ready.

OK

Secure Print / Sample Print 

Energy Saver

Back

Cancel Job 

Menu

Error Ready 

32 4 51

678910
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Securing the Printer
To protect your printer from theft, you can use the optional Kensington lock.
Attach the Kensington lock to the security slot on your printer.

For details, see the operating instructions supplied with the Kensington lock.

Security slot
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Preparing Printer Hardware

1 Open the side cover.

2 Completely pull out the eight yellow ribbons.

3 Close the side cover.
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Installing Optional Accessories
You can make the printer more functional by installing the optional accessories. This section describes 
how to install the printer's options such as the optional memory module and optional 250-sheet feeder.
This section includes:

• "Installing the Optional Memory Module" on page 39
• "Installing the Optional 250-Sheet Feeder" on page 42
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Installing the Optional Memory Module
NOTE: 
• Your printer supports additional 512 MB memory module.

1 Turn off the printer.

2 Turn the screw on the control board cover counterclockwise, and open the cover.

NOTE: 
• Loosen the screw. You do not need to remove the screw.

3 Align the connector of the memory module with the slot and insert the memory module into the 
slot.

4 Push the memory module firmly into the slot.
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NOTE: 
• Ensure that the memory module is firmly fixed in the slot and does not move easily.

5 Close the control board cover, and turn the screw clockwise.

6 Turn on the printer.

7 Print the Printer Settings page to confirm that the newly installed memory module is detected by 
the printer.
a Press the Menu button.
b Select Report/List, and then press the  button.
c Select Printer Settings, and then press the  button.

The Printer Settings page is printed.

8 Confirm the amount of Memory Capacity listed under General in the Printer Settings page.
If the memory capacity has not increased, turn off the printer, unplug the power cord, and 
re-install the memory module.

9 If you installed the optional memory module after installing the print driver, update your driver by 
following the instructions for the operating system you are using. If the printer is on a network, 
update the driver for each client.



41 Basic Operation

Updating Your Driver to Detect Optional Memory Module
The following procedure uses Microsoft® Windows® and the PCL 6 driver as an example.

If the printer information is not updated automatically after clicking Get Information from Printer, 
follow these steps:

1 Click the Options tab, and then select Memory Capacity in Items.

2 Select the total amount of the installed printer memory in Memory Capacity.

3 Click Apply, and then click OK.

4 Close the Printers and Faxes (, Printers, or Devices and Printers) folder.

Microsoft® 
Windows® 
7/Windows 7 x64/
Windows Server® 
2008 R2 x64

1 Click Start → Devices and Printers.
2 Right-click the printer icon of the DocuPrint CP305 d 

and select Printer properties.
3 Click the Options tab, and then click Get Information 

from Printer.
4 Click Apply, and then click OK.
5 Close the Devices and Printers folder.

Windows Vista®/
Windows Vista x64

1 Click Start → Control Panel → Hardware and Sound 
→ Printers.

2 Right-click the printer icon of the DocuPrint CP305 d 
and select Properties.

3 Click the Options tab, and then click Get Information 
from Printer.

4 Click Apply, and then click OK.
5 Close the Printers folder.

Windows Server 
2008/
Windows Server 
2008 x64

1 Click Start → Control Panel → Printers.
2 Right-click the printer icon of the DocuPrint CP305 d 

and select Properties.
3 Click the Options tab, and then click Get Information 

from Printer.
4 Click Apply, and then click OK.
5 Close the Printers folder.

Windows XP/
Windows XP x64/
Windows Server 
2003/
Windows Server 
2003 x64

1 Click Start (start for Windows XP) → Printers and 
Faxes.

2 Right-click the printer icon of the DocuPrint CP305 d 
and select Properties.

3 Click the Options tab, and then click Get Information 
from Printer.

4 Click Apply, and then click OK.
5 Close the Printers and Faxes folder.
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Installing the Optional 250-Sheet Feeder
1 Turn off the printer.

2 Disconnect the power cord from the power connector on the rear of the printer.

3 Remove the tape and the bag holding the screws.

4 Place the optional 250-sheet feeder in the location that the printer is located.

5 Pull the standard 250-sheet tray out of the printer about 200 mm. Hold the standard 250-sheet 
tray with both hands, and remove it from the printer.

6 Lift the printer and align the five guide pins of the optional 250-sheet feeder with the holes at the 
bottom of the printer. Gently lower the printer onto the optional 250-sheet feeder.

CAUTION:
• Two people are required to lift the printer.
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7 Secure the optional 250-sheet feeder to the printer by tightening the two screws provided with 
the feeder with a coin or similar object.

8 Insert the standard 250-sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

9 Reconnect all cables into the rear of the printer and turn on the printer.

NOTE: 

CAUTION:
• Be careful not to pinch your fingers when lowering the printer onto the optional 250-sheet feeder. 
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• The printer will automatically detect the attached tray but will not detect the paper type.

10 Print the Printer Settings page to confirm the optional 250-sheet feeder is installed correctly.
a Press the Menu button.
b Select Report/List, and then press the  button.
c Select Printer Settings, and then press the  button.

The Printer Settings page is printed.

11 Confirm Tray 2 (250 Sheet Feeder) is listed under Printer Options in the Printer Settings page.
If the feeder is not listed, turn off the printer, unplug the power cord, and re-install the optional 
250-sheet feeder.

12 After loading paper in the optional 250-sheet feeder, specify the paper type from the printer 
operator panel.
a Press the Menu button.
b Select Tray Settings, and then press the  button.
c Select Tray 2, and then press the  button.
d Select Paper Type, and then press the  button.
e Select the paper type for the optional 250-sheet feeder, and then press the  button.

13 If you installed the optional 250-sheet feeder after installing the print driver, update your driver by 
following the instructions for each operating system. If the printer is on a network, update the 
driver for each client.
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Updating Your Driver to Detect Optional 250-Sheet Feeder
The following procedure uses Microsoft® Windows® and the PCL 6 driver as an example.

If the printer information is not updated automatically after clicking Get Information from Printer, 
follow these steps:

1 Click the Options tab, and then select Paper Tray Configuration in Items.

2 Select Two trays for the optional 250-sheet feeder setting in Paper Tray Configuration.

3 Click Apply, and then click OK.

4 Close the Printers and Faxes (, Printers, or Devices and Printers) folder.

Microsoft Windows 
7/
Windows 7 x64/
Windows Server 
2008 R2 x64

1 Click Start → Devices and Printers.
2 Right-click the printer icon of the DocuPrint CP305 d 

and select Printer properties.
3 Click the Options tab, and then click Get Information 

from Printer.
4 Click Apply, and then click OK.
5 Close the Devices and Printers folder.

Windows Vista/
Windows Vista x64

1 Click Start → Control Panel → Hardware and Sound 
→ Printers.

2 Right-click the printer icon of the DocuPrint CP305 d 
and select Properties.

3 Click the Options tab, and then click Get Information 
from Printer.

4 Click Apply, and then click OK.
5 Close the Printers folder.

Windows Server 
2008/
Windows Server 
2008 x64

1 Click Start → Control Panel → Printers.
2 Right-click the printer icon of the DocuPrint CP305 d 

and select Properties.
3 Click the Options tab, and then click Get Information 

from Printer.
4 Click Apply, and then click OK.
5 Close the Printers folder.

Windows XP/
Windows XP x64/
Windows Server 
2003/
Windows Server 
2003 x64

1 Click Start (start for Windows XP) → Printers and 
Faxes.

2 Right-click the printer icon of the DocuPrint CP305 d 
and select Properties.

3 Click the Options tab, and then click Get Information 
from Printer.

4 Click Apply, and then click OK.
5 Close the Printers and Faxes folder.
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Turning on the Printer
IMPORTANT: 
• Do not use extension cords or power strips.
• The printer should not be connected to an uninterrupted power supply (UPS) system.

1 Connect the power cord to the power connector on the rear of your printer.

2 Connect the other end of the power cord to the power source.

3 Turn on the printer.
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Printing a Panel Settings Page
The Panel Settings page shows current settings for the operator panel menus. 

1 Press the Menu button.

2 Select Report/List, and then press the  button.

3 Select Panel Settings, and then press the  button.
The Panel Settings page is printed.
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Power Saver Mode
The printer has a power saving feature that reduces power consumption during periods of inactivity. 
This feature operates in two modes: the Low Power mode and Sleep mode. As delivered, the printer 
switches to the Low Power mode three minutes after the last print job is printed. The printer then 
switches to the Sleep mode after another six minutes of inactivity. When the printer is in the Low 
Power mode, the LCD backlight turns off. In the Sleep mode, Energy Saver button lights up. The 
display also goes blank and displays nothing.
The factory default settings of three minutes (Low Power mode) and six minutes (Sleep mode) are 
changeable within the range of 3 to 60 minutes (Low Power mode) and 1 to 6 minutes (Sleep mode). 
The printer returns to the ready-to-print state in about 30 seconds when re-activated.

See also: 
• "Setting the Power Saver Time Option" on page 176.
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Exiting the Power Saver Mode
The printer automatically exits the Power Saver mode when it receives a print job from a computer. To 
manually exit the Low Power mode, press any button on the operator panel. To exit the Sleep mode, 
press the Energy Saver button. 

NOTE: 
• Opening and closing a cover will cause the printer to exit the Low Power mode and the Sleep mode.
• When the printer is in the Sleep mode, all buttons on the operator panel except for the Energy Saver button do 

not function. To use the buttons on the operator panel, press the Energy Saver button to exit the Sleep mode.

See also: 
• "Setting the Power Saver Time Option" on page 176.
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3
Printer Management Software

Use the CD-ROMs shipped with your printer to install a combination of software programs, depending 
on your operating system.
This chapter includes:

• "Print Drivers" on page 52
• "CentreWare Internet Services" on page 53
• "SimpleMonitor (Windows Only)" on page 55
• "Setup Disk Creation Tool (Windows Only)" on page 56
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Print Drivers
To access all of your printer's features, install the print drivers from the Driver CD Kit or PostScript 
Driver Library CD.

• The print drivers enable your computer and printer to communicate and provide access to your 
printer features.
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CentreWare Internet Services
This section provides information on CentreWare Internet Services, a hyper text transfer protocol 
(HTTP)-based web page service that installs with your print driver and is accessed through your web 
browser. 
These pages give you instant access to printer status, and printer configuration options. Anyone on 
your network can access the printer using their web browser software. In administrative mode you can 
change the configuration of the printer, and manage your printer settings without leaving your 
computer.

NOTE: 
• Users who are not given passwords by the administrator can still view the configuration settings and options in 

user mode. They will not be able to save or apply any changes to the current configuration.
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Creating an Administrative Password
1 Launch your web browser.

2 Enter the IP address in the browser’s Address field, and then press the Enter key.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select Administrator Settings.

5 Select Enabled for Administrator Mode. 

6 In the Administrator Login ID field, enter a name for the administrator.

NOTE: 
• The default ID and password are “11111” and “x-admin”, respectively.

7 In the Administrator Password and Re-enter Password fields, enter a password for the 
administrator.

8 In the Maximum Login Attempts field, enter the number of login attempts allowed.

9 Click Apply. Your new password has been set and anyone with the administrator name and 
password can log in and change the printer configuration and settings.
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SimpleMonitor (Windows Only)
You can check the printer status with SimpleMonitor. Double-click the SimpleMonitor printer icon on 
the taskbar at the bottom right of the screen. The Select Printer window appears, which displays the 
printer name, printer connection ports, and printer status. Check the column Status to know the 
current status of your printer. 
Status Settings button: Displays the Status Settings dialog box and allows you to modify the 
SimpleMonitor settings.
Click the name of the desired printer listed on the Select Printer window. The Printer Status window 
appears.
The Printer Status window alerts you when there is a warning or when an error occurs, for example, 
when a paper jam occurs or toner is running low.
By default, the Printer Status window launches when printing and an error occurs. When an error 
occurs, the error message appears on the Printer Status window. You can specify the conditions for 
starting the Printer Status window in Auto start setup.

To change the pop-up settings for the Printer Status window:
The following procedure uses Microsoft® Windows® XP as an example.

1 Click start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate 
SimpleMonitor.
The Select Printer window appears.

2 Click Status Settings.
The Status Settings dialog box appears.

3 Select the Pop-up Settings tab, and then select the type of the pop-up from Auto start setup.
You can also check the toner level of your printer.

SimpleMonitor can be installed from the Driver CD Kit. It is available only for Windows.
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Setup Disk Creation Tool (Windows Only)
The Setup Disk Creation Tool on the Driver CD Kit and the print drivers on the Driver CD Kit and 
PostScript Driver Library CD are used to create driver installation packages that contain custom driver 
settings. A driver installation package can contain a group of saved print driver settings and other data 
for things such as:

• Print orientation and Multiple Up (document settings)
• Watermarks
• Font references

If you want to install the print driver with the same settings on multiple computers running the same 
operating system, create a setup disk in a floppy disk or in a server on the network. Using the setup 
disk that you have created will reduce the amount of work required when installing the print driver.

• Install the DocuPrint CP305 d driver in the computer on which the setup disk is to be created.
• The setup disk can only be used on the operating system on which the disk was created or 

computers running the same operating system. Create a separate setup disk for each of the 
operating systems.
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4
Network Basics

This chapter includes:
• "Overview of Network Setup and Configuration" on page 58
• "Connecting Your Printer" on page 59
• "Setting the IP Address" on page 63
• "Installing Print Driver on Computers Running Windows" on page 71
• "Installing Print Driver on Computers Running Mac OS X" on page 81
• "Installing Print Driver on Computers Running Linux (CUPS)" on page 82
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Overview of Network Setup and Configuration
To set up and configure the network:

1 Connect the printer to the network using the recommended hardware and cables.

2 Turn on the printer and the computer.

3 Print the Printer Settings page and keep it for referencing network settings. 

4 Install the driver software on the computer from the Driver CD Kit or PostScript Driver Library CD. 
For information on driver installation, see the section in this chapter for the specific operating 
system you are using.

5 Configure the printer’s TCP/IP address, which is required to identify the printer on the network. 
• Microsoft® Windows® operating systems: Run the Installer on the Driver CD Kit or PostScript 

Driver Library CD to automatically set the printer’s IP address if the printer is connected to an 
established TCP/IP network. You can also manually set the printer’s IP address on the 
operator panel.

• Mac OS® X and Linux systems: Manually set the printer’s TCP/IP address on the operator 
panel.

6 Print a Printer Settings page to verify the new settings.

NOTE: 
• If the Driver CD Kit or PostScript Driver Library CD is not available, you can download the latest driver from 

the Fuji Xerox Web Site: http://www.fujixeroxprinters.com/ 

See also: 
• "Printing a Printer Settings Page" on page 136

http://www.fujixeroxprinters.com/
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Connecting Your Printer
Your DocuPrint CP305 d interconnection cables must meet the following requirements:

Connection Type Connection Specifications
USB USB 2.0

Ethernet 10 Base-T/100 Base-TX/1000 Base-TX

1 USB port

2 Ethernet port

1

2
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Connecting Printer to Computer or Network
Connect the printer via Ethernet or USB. A USB connection is a direct connection and is not used for 
networking. An Ethernet connection is used for networking. Hardware and cabling requirements vary 
for the different connection methods. Ethernet cable and hardware are generally not included with 
your printer and must be purchased separately.
The available features for each connection type are shown in the following table.

Connection Type Available Features
USB When connected via USB you can:

• Instruct print jobs from a computer.

Ethernet When connected via Ethernet you can:
• Instruct print jobs from a computer on the network.
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USB Connection
A local printer is directly connected to your computer using the USB cable. If your printer is connected 
to a network instead of your computer, skip this section and go to "Network Connection" on page 62.
To connect the printer to a computer:

1 Connect the smaller USB connector into the USB port on the rear of the printer.

NOTE: 
• Ensure that you match the USB symbol on the cable to the USB symbol on the printer.

2 Connect the other end of the cable into a USB port of the computer.

NOTE: 
• Do not connect the printer USB cable to the USB port available on the keyboard.



Network Basics 62

Network Connection
To connect the printer to a network:

1 Connect an Ethernet cable.

To connect the printer to the network, connect one end of the Ethernet cable into the Ethernet port on 
the rear of the printer, and the other end to a LAN drop or hub.
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Setting the IP Address
This section includes:

• "TCP/IP and IP Addresses" on page 64
• "Automatically Setting the Printer’s IP Address" on page 65
• "Dynamic Methods of Setting the Printer’s IP Address" on page 66
• "Assigning an IP Address (for IPv4 Mode)" on page 67
• "Verifying the IP Settings" on page 69
• "Printing and Checking the Printer Settings Page" on page 70
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TCP/IP and IP Addresses
If your computer is on a large network, contact your network administrator for the appropriate TCP/IP 
addresses and additional system settings information. 
If you are creating your own small Local Area Network or connecting the printer directly to your 
computer using Ethernet, follow the procedure for automatically setting the printer’s IP address. 
Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. 
With TCP/IP protocols, each printer and computer must have a unique IP address. It is important that 
the addresses are similar, but not the same; only the last digit needs to be different. For example, your 
printer can have the address 192.168.1.2 while your computer has the address 192.168.1.3. Another 
device can have the address 192.168.1.4.
Many networks have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically programs an IP address into every computer and printer on the network that is 
configured to use DHCP. A DHCP server is built into most cable and Digital Subscriber Line (DSL) 
routers. If you use a cable or DSL router, see your router’s documentation for information on IP 
addressing.
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Automatically Setting the Printer’s IP Address
If the printer is connected to a small established TCP/IP network without a DHCP server, use the 
installer on the Driver CD Kit or PostScript Driver Library CD to detect or assign an IP address to your 
printer. For further instructions, insert the Driver CD Kit or PostScript Driver Library CD into your 
computer’s CD-ROM drive. After the Installer launches, follow the prompts for installation. 

NOTE: 
• For the automatic installer to function, the printer must be connected to an established TCP/IP network.
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Dynamic Methods of Setting the Printer’s IP Address
There are two protocols available for dynamically setting the printer’s IP address: 

• DHCP (enabled by default)
• AutoIP

You can turn on/off both protocols using the operator panel, or use CentreWare Internet Services to 
turn on/off DHCP.

NOTE: 
• You can print a report that includes the printer’s IP address. On the operator panel, press the Menu button, 

select Report/List, press the  button, select Printer Settings, and then press the  button. The 
IP address is listed on the Printer Settings page.

Using the Operator Panel
To turn on/off either the DHCP or AutoIP protocol:

1 On the operator panel, press the Menu button.

2 Select Admin Menu, and then press the  button.

3 Select Wired Network, and then press the  button.

4 Select TCP/IP, and then press the  button.

5 Select IPv4, and then press the  button.

6 Select Get IP Address, and then press the  button.

7 Select DHCP / Autonet, and then press the  button.

Using CentreWare Internet Services
To turn on/off the DHCP protocol:

1 Launch your web browser.

2 Enter the IP address in the browser’s Address field, and then press the Enter key.

3 Select Properties.

4 Select the Protocol Settings folder on the left navigation panel.

5 Select TCP/IP.

6 In the Get IP Address field, select the DHCP / Autonet option.

7 Click the Apply button.
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Assigning an IP Address (for IPv4 Mode)
NOTE: 
• When you assign an IP address manually in IPv6 mode, use the CentreWare Internet Services. To display the 

CentreWare Internet Services, use the link local address. To check a link local address, see "Printing and 
Checking the Printer Settings Page" on page 70.

• Assigning an IP address is considered as an advanced function and is normally done by a system 
administrator.

• Depending on the address class, the range of the IP address assigned may be different. On Class A, for 
example, an IP address in the range from 0.0.0.0 to 127.255.255.255 will be assigned. For 
assignment of IP addresses, contact your system administrator. 

You can assign the IP address by using the operator panel.

1 Turn on the printer.
Ensure that Ready message appears on the LCD panel.

2 On the operator panel, press the Menu button.

3 Select Admin Menu, and then press the  button.

4 Select Wired Network, and then press the  button.

5 Select TCP/IP, and then press the  button.

6 Select IPv4, and then press the  button.

7 Select Get IP Address, and then press the  button.

8 Select Panel, and then press the  button.

9 Ensure that the message Restart Printer to apply setting appears, and then press 
any button.

10 Press the  button to select IP Address, and then press the  button.
The cursor is located at the first octet of the IP address.

11 Specify the value of the IP address using the  or  button.

12 Press the  button.
The cursor moves to the next octet.

13 Repeat steps 11 to 12 to set all of the digits in the IP address, and then press the  button.

14 Ensure that the message Restart Printer to apply setting appears, and then press 
any button.

15 Press the  button to select Subnet Mask, and then press the  button.
The cursor is located at the first octet of the subnet mask.

16 Specify the value of the subnet mask using the  or  button.

17 Press the  button.
The cursor moves to the next octet.

18 Repeat steps 16 to 17 to set subnet mask, and then press the  button.
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19 Ensure that the message Restart Printer to apply setting appears, and then press 
any button.

20 Press the  button to select Gateway Address, and then press the  button.
The cursor is located at the first octet of the gateway address.

21 Specify the value of the gateway address using the  or  button.

22 Press the  button.
The cursor moves to the next octet.

23 Repeat steps 21 to 22 to set gateway address, and then press the  button.

24 Ensure that the message Restart Printer to apply setting appears, and then press 
any button.

25 Turn off and turn on the printer.

See also: 
• "Operator Panel" on page 35
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Verifying the IP Settings
You can confirm the settings by printing the system settings report or using the ping command.
The following procedure uses Windows XP as an example.

1 Print the Printer Settings page.

2 Look under the IPv4 heading on the Printer Settings page to ensure that the IP address, subnet 
mask, and gateway are appropriate.

To verify if the printer is active on the network, run the ping command in your computer:

1 Click start, and select Run.

2 Enter cmd, and then click OK.
A black window is displayed.

3 Enter ping xx.xx.xx.xx (where xx.xx.xx.xx is the IP address of your printer), and then press the 
Enter key.

4 Reply from the IP address denotes printer is active on the network.

See also: 
• "Printing and Checking the Printer Settings Page" on page 70
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Printing and Checking the Printer Settings Page
Print the Printer Settings page and check your printer's IP address by using the operator panel.

1 On the operator panel, press the Menu button.

2 Select Report/List, and then press the  button.

3 Select Printer Settings, and then press the  button.
The Printer Settings page is printed.

4 Confirm the IP address next to IP Address under Network (Wired) on the Printer Settings page. 
If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and 
then print the Printer Settings page again.
If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on 
page 67.
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Installing Print Driver on Computers Running 
Windows
This section includes:

• "Identifying Print Driver Pre-install Status (For Network Connection Setup)" on page 72
• "Inserting the CD-ROM" on page 73
• "USB Connection Setup" on page 74
• "Network Connection Setup" on page 75
• "Setting Up for Shared Printing" on page 76
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Identifying Print Driver Pre-install Status (For Network 
Connection Setup)

Before installing the print driver on your computer, print the Printer Settings page to check the IP 
address of your printer.
This section includes:

• "The Operator Panel" on page 72
• "Disabling the Firewall Before Installing Your Printer" on page 72

The Operator Panel

1 Press the Menu button.

2 Select Report/List, and then press the  button.

3 Select Printer Settings, and then press the  button.
The Printer Settings page is printed.

4 Find the IP address under Network (Wired) on the Printer Settings page.
If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and 
then print the Printer Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on 
page 67.

Disabling the Firewall Before Installing Your Printer
NOTE: 
• For Windows XP, Service Pack 2 or 3 must be installed.

If you are running one of the following operating systems, you must disable the firewall before 
installing the Fuji Xerox printer software:

• Windows 7
• Windows Vista
• Windows Server 2008 R2
• Windows Server 2008
• Windows XP

The following procedure uses Windows XP as an example.

1 Click start → Help and Support.

NOTE: 
• For Windows Vista, Windows Server 2008, Windows Server 2008 R2 and Windows 7 operating systems, 

if you use Online Help, switch to Offline Help on Windows Help and Support window.

2 In the Search box, enter firewall and then press the Enter key.
In the list, click Turn Windows Firewall on or off and then follow the instructions on the screen.

Enable the firewall after the installation of the Fuji Xerox printer software is complete.
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Inserting the CD-ROM

For Installing PCL Print Driver

1 Insert the Driver CD Kit into your computer to start Easy Install Navi.

NOTE: 
• If the CD does not automatically launch, click Start (start for Windows XP) → All Programs (for 

Windows Vista and Windows 7) → Accessories (for Windows Vista and Windows 7) → Run, and then 
enter D:\setup.exe (where D is the drive letter of your CD), and then click OK.

For Installing PostScript Print Driver

1 Insert the PostScript Driver Library CD into your computer.
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USB Connection Setup

For Installing PCL Print Driver

1 Click Installing Driver and Software.

2 Click Print Driver. 

3 Click Connect via USB.

4 Follow the procedures described in the Help to install the print driver.

• USB Printing
A personal printer is a printer attached to your computer or a print server using a USB. If your printer is 
attached to a network and not your computer, see "Network Connection Setup" on page 75.

For Installing PostScript Print Driver
Windows users should read the PostScript User Guide for information on how to install the print driver.
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Network Connection Setup
NOTE: 
• To use this printer in a Linux environment, you need to install a Linux driver. For more information on how to 

install and use these, see also "Installing Print Driver on Computers Running Linux (CUPS)" on page 82.
• When using a CD drive in a Linux environment, you need to mount the CD according to your system 

environment. The command strings are mount/media/CD-ROM.

For installing PCL print driver

1 Click Installing Driver and Software.

2 Click Print Driver. 

3 Select Standard or Custom setup.

4 Follow the on-screen instructions to install the print driver.

For installing PostScript print driver
Windows users should read the PostScript User Guide for information on how to install the print driver.
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Setting Up for Shared Printing
You can share your new printer on the network using the Driver CD Kit that comes with your printer, or 
using Microsoft peer-to-peer method. However, if you use the Microsoft method, some features, such 
as the SimpleMonitor and other printer utilities, installed with the Driver CD Kit, may not be available.
If you want to use the printer on a network, share the printer and install its drivers on all the computers 
on the network.

NOTE: 
• You need to purchase an Ethernet cable for shared printing.

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon and select Properties.

3 On the Sharing tab, select the Share this printer radio button, and then enter a name in Share 
name text box.

4 Click Additional Drivers and select the operating systems of all network clients that print to the 
printer.

5 Click OK.
If you are missing files, you are prompted to insert the server operating system CD.

6 Click Apply, and then click OK.

• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.

3 Click Change sharing options.
The message Windows needs your permission to continue appears.

4 Click Continue.

5 Select the Share this printer check box, and then enter a name in Share name.

6 Click Additional Drivers and select the operating systems of all network clients that print to the 
printer.

7 Click OK.

8 Click Apply, and then click OK.
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• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon and select Sharing.

3 Select the Share this printer check box, and then enter a name in Share name.

4 Click Additional Drivers and select the operating systems of all network clients that print to the 
printer.

5 Click OK.

6 Click Apply, and then click OK.

• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2 

1 Click Start → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, select the Share this printer check box, and then enter a name in Share 
name text box.

4 Click Additional Drivers and select the operating systems of all network clients that print to the 
printer.

5 Click OK.

6 Click Apply, and then click OK.
To confirm that the printer is properly shared:

• Ensure that the printer object in the Printers, Printers and Faxes or Devices and Printers 
folder is shared. The shared icon is shown under the printer icon.

• Browse Network or My Network Places. Find the host name of the server and the shared name 
you assigned to the printer.

Now that the printer is shared, you can install the printer on network clients using the peer-to-peer 
method.

Peer-to-Peer
If you use the peer-to-peer method, the print driver is fully installed on each client computer. Network 
clients retain control of driver modifications. The client computer handles the print job processing.
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• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 Click start (Start for Windows Server 2003 / Windows Server 2003 x64 Edition) → Printers and 
Faxes.

2 Click Add a printer (Add Printer for Windows Server 2003 / Windows Server 2003 x64 Edition) 
to launch the Add Printer Wizard.

3 Click Next.

4 Select A network printer, or a printer attached to another computer, and then click Next. If 
the printer is not listed, enter the path to the printer in the text box.

The server host name is the name of the server computer that identifies it on the network. The 
shared printer name is the name assigned during the server installation process.

5 Click Browse for a printer, and then click Next.

6 Select the printer, and then click Next.
If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, you need to specify the path to available drivers.

7 Select Yes if you want this printer to be set as the default printer, and then click Next.
If you want to verify installation, click Yes to print a test page.

8 Click Finish.
When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, 
select the printer and click Next, or select The printer that I want isn't listed and enter the path 
of the printer in Select a shared printer by name and click Next.

The server host name is the name of the server computer that identifies it on the network. The 
shared printer name is the name assigned during the server installation process.

4 If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, you need to specify the path to available drivers.

5 Select Yes if you want this printer to be set as the default printer, and then click Next.

6 If you want to verify installation, click Print a test page.

7 Click Finish.
When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, 
select the printer and click Next, or select The printer that I want isn't listed and enter the path 
to the printer in Select a shared printer by name and click Next.
For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. The 
shared printer name is the name assigned during the server installation process.

4 If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, you will need to provide a path to available drivers.

5 Select Yes if you want this printer to be set as the default printer, and then click Next.

6 Click Print a test page if you want to verify installation.

7 Click Finish.
When a test page prints successfully, installation is complete.

• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed. Click Select a shared printer by 
name and enter the path of the printer in the text box, and then click Next.
For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it to the network. The 
shared printer name is the name assigned during the server installation process.

4 If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, you will need to provide the path to the available driver.

5 Confirm the printer name, and then click Next.

6 Select Yes if you want this printer to be set as the default printer, and then click Next.

7 Click Print a test page if you want to verify installation.

8 Click Finish.
When a test page prints successfully, installation is complete.
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Installing Print Driver on Computers Running Mac 
OS X
For information on how to install the print driver, refer to the PostScript User Guide.
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Installing Print Driver on Computers Running Linux 
(CUPS)
This section provides information for installing or setting up the print driver with CUPS (Common UNIX 
Printing System) on Red Hat® Enterprise Linux® 4 WS/5 Client or SUSE® Linux Enterprise Desktop 
10/11.
This section includes:

• "Installing the Print Driver" on page 83
• "Setting Up the Queue" on page 84
• "Setting the Default Queue" on page 87
• "Specifying the Printing Options" on page 88
• "Setting the Password for Authority as the Printer Administrator" on page 90
• "Uninstalling the Print Driver" on page 91
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Installing the Print Driver
This section includes:

• "For Red Hat Enterprise Linux 4 WS/5 Client" on page 83
• "For SUSE Linux Enterprise Desktop 10" on page 83
• "For SUSE Linux Enterprise Desktop 11" on page 83

NOTE: 
• The print driver Fuji_Xerox-DocuPrint_CP305_d-x.x-y.noarch.rpm is included in the Linux folder in the 

Common folder on the Driver CD Kit.

• For Red Hat Enterprise Linux 4 WS/5 Client
IMPORTANT: 
• Before you install the print driver on Red Hat Enterprise Linux 4, confirm that Update 8 or higher is applied to 

your operating system. Consult your Linux distributor for the upgrade of your system.

1 Double-click Fuji_Xerox-DocuPrint_CP305_d-x.x-y.noarch.rpm in the Driver CD Kit.

2 Enter the administrator's password.

3 Click Continue in the Completed System Preparation window.
Installation starts. When the installation is complete, the window is automatically closed.

• For SUSE Linux Enterprise Desktop 10

1 Double-click Fuji_Xerox-DocuPrint_CP305_d-x.x-y.noarch.rpm in the Driver CD Kit.

2 Enter the administrator password, and click Install.
Installation starts. When the installation is complete, the window is automatically closed.

• For SUSE Linux Enterprise Desktop 11

1 Double-click Fuji_Xerox-DocuPrint_CP305_d-x.x-y.noarch.rpm in the Driver CD Kit.

2 Enter the administrator password, and click Continue.
Installation starts. When the installation is complete, the window is automatically closed.
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Setting Up the Queue
To execute printing, you must set up the print queue on your workstation.

NOTE: 
• When you have finished setting up the queue, you can print jobs from the applications. Start the print job from 

the application, and specify the queue in the print dialog box. 
However, you may be able to print only from the default queue depending on the application (for example 
Mozilla). In these cases, before you start printing, set queue you want to print to as the default queue. For 
information on specifying the default queue, see also "Setting the Default Queue" on page 87.

• For Red Hat Enterprise Linux 4 WS/5 Client

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Enter root as the user name, and enter the administrator password.

4 Click Add Printer.
Enter the name of the printer in Name in the Add New Printer window, and click Continue.

You can optionally specify the location and description of the printer for further information.

For network connections:

a Select LPD/LPR Host or Printer from the Device menu, and click Continue.
b Enter the IP address of the printer in Device URI. 
c Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer)
For USB connections with Red Hat Enterprise Linux 4 WS:

a Select USB Printer #1 from the Device menu.
For USB connections with Red Hat Enterprise Linux 5 Client:

a Select DocuPrint XXX USB #1 or DocuPrint XXX from the Device menu.

5 Select Fuji Xerox from the Make menu, and click Continue.

6 Select DocuPrint XXX from the Model menu, and click Continue.
The message Printer xxx has been added successfully. appears.

The setup is complete.
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• For SUSE Linux Enterprise Desktop 10

1 Select Computer → More Applications... and select YaST on the Application Browser.

2 Enter the administrator password.
YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and select Printer.

4 Printer setup: Autodetected printers is activated.
For network connections:

a Click Add.
b Select Network Printers as Printer Type, and click Next.
c Select the Print via LPD-Style Network Server as Printer Type, and click Next.
d Enter the IP address of the printer in Host name of the printer server. 
e Enter the name of the printer queue in Name of the remote queue, and click Next.
f Enter the printer name in Name for printing.

NOTE: 
• The Description of Printer and Location of Printer do not have to be specified.

g Select the Do Local Filtering check box, and click Next.
h Select Fuji Xerox as Select manufacturer. Select XXX as Select Model, and click Next.
i Confirm the settings in Edit configuration, and click OK.
For USB connections:

a Select DocuPrint XXX on USB (//DocuPrint/XXX or /dev/usblp*) as Available are, and 
click Configure….

b Confirm the settings in Edit configuration, and click OK.

5 Click Finish.
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• For SUSE Linux Enterprise Desktop 11

1 Select Computer → More Applications..., and select YaST on the Application Browser.

2 Enter the administrator password.
YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and select Printer.
The Printer Configurations dialog box opens.

For network connections:

a Click Add.
The Add New Printer Configuration dialog box opens.

b Click Connection Wizard.
The Connection Wizard dialog box opens.

c Select Line Printer Daemon (LPD) Protocol from Access Network Printer or Printserver 
Box via.

d Enter the IP address of the printer in IP Address or Host Name:.
e Select Fuji Xerox in Select the printer manufacturer:.
f Click OK.

The Add New Printer Configuration dialog box appear.

g Select DocuPrint XXX vx.x [DocuPrint/DocuPrint_XXX.ppd.gz] from the Search for 
Drivers: list.

NOTE: 
• You can specify the printer name in Set Name:.
h Confirm the settings, and click OK.
For USB connections:

a Click Add.
The Add New Printer Configuration dialog box opens.

The printer name is displayed in the Determine Connection list.

b Select DocuPrint XXX vx.x. [DocuPrint/DocuPrint_XXX.ppd.gz] from the Search for 
Drivers: list.

NOTE: 
• You can specify the printer name in Set Name:.
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Setting the Default Queue

• For Red Hat Enterprise Linux 4 WS/5 Client

1 Select Applications → System Tools → Terminal.

2 Enter the following command in the terminal window.

• For SUSE Linux Enterprise Desktop 10

1 To activate the Printer setup: Autodetected printers, do the following.
a Select Computer → More Applications... and select YaST on the Application Browser.
b Enter the administrator password.

YaST Control Center is activated.

c Select Hardware on YaST Control Center, and select Printer.

2 Select the printer you want to set to default on the Printer Configuration, and select Set default 
in the Other button menu.

3 Click Finish.

• For SUSE Linux Enterprise Desktop 11

1 Select Computer → More Applications..., and select YaST on the Application Browser.

2 Enter the administrator password.
YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and select Printer.
The Printer Configurations dialog box opens.

4 Click Edit.
A dialog box to modify the specified queue opens.

5 Confirm that the printer you want to set is selected in the Connection list.

6 Select the Default Printer check box.

7 Confirm the settings, and click OK.

su

(Enter the administrator password)

lpadmin -d (Enter the queue name)
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Specifying the Printing Options
You can specify the printing options such as the color mode or 2-sided printing.

• For Red Hat Enterprise Linux 4 WS/5 Client

1 Open the URL "http://localhost:631" using a web browser.

2 Click Manage Printers.

3 Click Configure Printer of the queue for which you want to specify the printing options.

4 Enter root as the user name, and enter the administrator password.

5 Specify the required settings, and click Continue.
The message Printer xxx has been configured successfully. appears.

The setting is complete. 

• For SUSE Linux Enterprise Desktop 10

1 Open a web browser.

2 Enter http://localhost:631/admin in Location, and press the Enter key.

3 Enter root as the user name, and enter the administrator password.
The CUPS window appears.

NOTE: 
• Set the password for authority as the printer administrator before setting the printer queue. If you have not set 

it, go to "Setting the Password for Authority as the Printer Administrator" on page 90.

4 Click Manage Printers.

5 Specify the required settings, and click Continue.
The message Printer xxx has been configured successfully. appears.

The setting is complete. Execute printing from the application.
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• For SUSE Linux Enterprise Desktop 11

1 Open a web browser.

2 Enter http://localhost:631/admin in Location, and press the Enter key.

3 Enter root as the user name, and enter the administrator password.
The CUPS window appears.

NOTE: 
• Set the password for authority as the printer administrator before setting the printer queue. If you have not set 

it, go to "Setting the Password for Authority as the Printer Administrator" on page 90.

4 Click Manage Printers.

5 Specify the required settings, and click Continue.
The message Printer xxx has been configured successfully. appears.

The setting is complete. Execute printing from the application.
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Setting the Password for Authority as the Printer 
Administrator

For SUSE Linux Enterprise Desktop 10 and 11, you must set the password for authority as the printer 
administrator to do operations as the printer administrator.

• For SUSE Linux Enterprise Desktop 10

1 Select Computer → More Applications... and select Konsole on the Application Browser.

2 Enter the following command in the terminal window.

• For SUSE Linux Enterprise Desktop 11

1 Select Computer → More Applications... and select GNOME Terminal on the Application 
Browser.

2 Enter the following command in the terminal window.

su

(Enter the administrator password)

lppasswd -g sys -a root

(Enter the password for authority as the printer administrator 
after the Enter password prompt.)

(Reenter the password for authority as the printer administrator 
after the Enter password again prompt.)

su

(Enter the administrator password)

lppasswd -g sys -a root

(Enter the password for authority as the printer administrator 
after the Enter password prompt.)

(Reenter the password for authority as the printer administrator 
after the Enter password again prompt.)
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Uninstalling the Print Driver

• For Red Hat Enterprise Linux 4 WS/5 Client

1 Select Applications → System Tools → Terminal.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

• For SUSE Linux Enterprise Desktop 10

1 Select Computer → More Applications... and select Konsole on the Application Browser.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

su

(Enter the administrator password)

/usr/sbin/lpadmin -x (Enter the print queue name)

su

(Enter the administrator password)

rpm -e Fuji_Xerox-DocuPrint_CP305_d

su

(Enter the administrator password)

/usr/sbin/lpadmin -x (Enter the print queue name)

su

(Enter the administrator password)

rpm -e Fuji_Xerox-DocuPrint_CP305_d
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• For SUSE Linux Enterprise Desktop 11

1 Select Computer → More Applications... and select GNOME Terminal on the Application 
Browser.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

su

(Enter the administrator password)

/usr/sbin/lpadmin -x (Enter the print queue name)

su

(Enter the administrator password)

rpm -e Fuji_Xerox-DocuPrint_CP305_d
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5
Printing Basics

This chapter includes:
• "About Print Media" on page 94
• "Supported Print Media" on page 98
• "Loading Print Media" on page 103
• "Setting Paper Sizes and Types" on page 114
• "Printing" on page 117
• "Printing With Web Services on Devices (WSD)" on page 138
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About Print Media
This section includes:

• "Print Media Usage Guidelines" on page 95
• "Print Media That Can Damage Your Printer" on page 96
• "Print Media Storage Guidelines" on page 97

Using paper that is not appropriate for the printer can cause paper jams, image quality problems, or 
printer failure. To achieve the best performance from your printer, we recommend you to use only the 
paper described in this section.
When using paper other than that recommended, contact the Fuji Xerox local representative office or 
an authorised dealer.
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Print Media Usage Guidelines
The printer tray accommodates most sizes and types of paper and other specialty media. Follow these 
guidelines when loading paper and media in the tray:

• Envelopes can be printed from the single sheet feeder (SSF) and standard 250-sheet tray.
• Fan paper or other specialty media before loading in the paper tray.
• Do not print on label stock once a label has been removed from a sheet.
• Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with 

release strips.
• Print all envelopes single-sided only. 
• Some wrinkling and embossing may occur when printing envelopes.
• Do not overload the paper tray. Do not load print media above the fill line on the inside of the 

paper width guides.
• Adjust the paper width guides to fit the paper size.
• If excessive jams or wrinkles occur, use paper or other media from a new package.

See also: 
• "Loading Print Media in the Standard 250-Sheet Tray and the Optional 250-Sheet Feeder" on page 105
• "Loading Envelope in the Standard 250-Sheet Tray" on page 107
• "Loading Print Media in the Single Sheet Feeder (SSF)" on page 110
• "Loading Envelope in the Single Sheet Feeder (SSF)" on page 111
• "Printing on Custom Size Paper" on page 133

WARNING:
• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 

When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Print Media That Can Damage Your Printer
The following paper types are not recommended for use with the printer:

• Chemically treated paper used to make copies without carbon paper, also known as carbonless 
paper, carbonless copy paper (CCP), or no carbon required (NCR) paper.

• Preprinted paper with chemicals that may contaminate the printer.
• Preprinted paper that can be affected by the temperature in the fuser unit.
• Preprinted paper that requires a registration (the precise print location on the page) greater than 

±0.09 inches, such as optical character recognition (OCR) forms.
In some cases, you can adjust registration with your software program to successfully print on 
these forms.

• Coated paper (erasable bond), synthetic paper, and thermal paper.
• Rough-edged, rough or heavily textured surface paper, or curled paper.
• Recycled paper containing more than 25% post-consumer waste that does not meet DIN 19 309.
• Multiple-part forms or documents.
• Print quality may deteriorate (blank spaces or blotches may appear in the text) when you print on 

talc or acid paper.

WARNING:
• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 

When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Print Media Storage Guidelines
For proper print media storage, the following guidelines will help to avoid media feeding problems and 
uneven print quality.

• Store print media in an environment where the temperature is approximately 70 °F/21 °C and the 
relative humidity is 40%.

• Store print media in dark, cool, relatively dry locations. Most paper items are susceptible to 
damage from ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and 
fluorescent bulbs, is particularly damaging to paper items. The intensity and length of exposure 
to visible light on paper items should be reduced as much as possible.

• Maintain constant temperatures and relative humidity.
• Avoid attics, kitchens, garages, and basements for storing print media. 
• Store print media flat. Print media should be stored on pallets, cartons, shelves, or in cabinets.
• Avoid having food or drinks in the area where print media is stored or handled.
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

paper in the original packaging. For most commercial cut-size grades, the ream wrapper 
contains an inner lining that protects the paper from moisture loss or gain.

• Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag 
and reseal it for protection. Some specialty media is packaged inside resealable plastic bags.

• Do not place anything on top of the print media packages.
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Supported Print Media
Using unsuitable print media may lead to paper jams, poor print quality, breakdown and damage to 
your printer. To use the features of this printer effectively, use the suggested print media that is 
recommended here.

IMPORTANT: 
• The toner may come off the print media, if it gets wet by water, rain, steam and so on. For details, contact the 

Fuji Xerox local representative office or an authorised dealer.
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Print Media Dimensions
The maximum dimensions of print media that the standard 250-sheet tray and SSF can handle are:

• Width: 76.2 mm (3.00 inches) to 215.9 mm (8.5 inches)
• Length: 127 mm (5.00 inches) to 355.6 mm (14.00 inches)

The maximum dimensions of print media that the optional 250-sheet feeder can handle are:
• Width: 148 mm (5.83 inches) to 215.9 mm (8.5 inches)
• Length: 210 mm (8.27 inches) to 355.6 mm (14.00 inches)
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Usable Print Media
The types of print media that can be used on this printer are as follows:

Single Sheet Feeder (SSF)

Paper Size A4 SEF (210 × 297 mm)

A5 SEF (148 × 210 mm)

B5 SEF (182 × 257 mm)

Letter SEF (8.5 × 11 inches)

Folio SEF (8.5 × 13 inches)

Legal SEF (8.5 × 14 inches)

Executive SEF (7.25 × 10.5 inches)

Com-10 SEF (4.125 × 9.5 inches)

Monarch Envelope SEF (3.875 × 7.5 inches)

DL Envelope SEF (110 × 220 mm)

C5 Envelope SEF (162 × 229 mm)

Custom Size:
Width: 76.2–215.9 mm (3–8.5 inches)
Length: 127–355.6 mm (5 –14 inches)

Paper Type (Weight) Plain

Plain Paper Light

Lightweight Cardstock

Heavyweight Cardstock

Envelope

Letterhead

Lightweight Glossy Cardstock

Heavyweight Glossy Cardstock

Hole Punched

Colored

Special

Loading Capacity 1 sheet of standard paper
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Standard 250-Sheet Tray

Paper Size A4 SEF (210 × 297 mm)

A5 SEF (148 × 210 mm)

B5 SEF (182 × 257 mm)

Letter SEF (8.5 × 11 inches)

Folio SEF (8.5 × 13 inches)

Legal SEF (8.5 × 14 inches)

Executive SEF (7.25 × 10.5 inches)

Com-10 SEF (4.125 × 9.5 inches)

Monarch Envelope SEF (3.875 × 7.5 inches)

Monarch Envelope LEF (7.5 × 3.8 inches)

DL Envelope SEF (110 × 220 mm)

DL Envelope LEF (220 × 110 mm)

C5 Envelope SEF (162 × 229 mm)

Custom Size:
Width: 76.2–215.9 mm (3–8.5 inches)*1

Length: 127–355.6 mm (5 –14 inches)*2

Paper Type (Weight) Plain

Plain Paper Light

Lightweight Cardstock

Heavyweight Cardstock

Envelope

Labels

Label Thick

Letterhead

Hole Punched

Colored

Special

Loading Capacity 250 sheets of standard paper
*1: Maximum width 220 mm for envelope (DL LEF)

DL and Monarch can be supported by LEF with flap opened.
*2: Minimum length 98.4 mm for envelope (Monarch LEF)
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Optional 250-Sheet Feeder

NOTE: 
• SEF and LEF indicate the paper feed direction; SEF stands for short-edge feed. LEF stands for 

long-edge feed.

See also: 
• "Loading Print Media in the Standard 250-Sheet Tray and the Optional 250-Sheet Feeder" on page 105
• "Loading Envelope in the Standard 250-Sheet Tray" on page 107
• "Loading Letterhead in the Standard 250-Sheet Tray and the Optional 250-Sheet Feeder" on page 109
• "Loading Print Media in the Single Sheet Feeder (SSF)" on page 110
• "Loading Envelope in the Single Sheet Feeder (SSF)" on page 111

Printing on print media that differs from the paper size or paper type selected on the print driver, or 
loading print media into an unsuitable paper tray for printing, may lead to paper jams. To ensure that 
printing is correctly done, select the correct paper size, paper type, and paper tray.

Paper Size A4 SEF (210 × 297 mm)

A5 SEF (148 × 210 mm)

B5 SEF (182 × 257 mm)

Letter SEF (8.5 × 11 inches)

Folio SEF (8.5 × 13 inches)

Legal SEF (8.5 × 14 inches)

Executive SEF (7.25 × 10.5 inches)

Paper Type (Weight) Plain

Plain Paper Light

Letterhead

Hole Punched

Colored

Loading Capacity 250 sheets of standard paper
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Loading Print Media
Loading print media properly helps prevent jams and ensures trouble-free printing.
Before loading any print media, identify the recommended print side of the print media. This 
information is usually indicated on the print media package.
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Capacity
The standard 250-sheet tray and optional 250-sheet feeder can hold:

• 250 sheets of the standard paper.
The SSF can hold:

• 1 sheet of the standard paper.
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Loading Print Media in the Standard 250-Sheet Tray and 
the Optional 250-Sheet Feeder

NOTE: 
• To avoid paper jams, do not remove the tray while printing is in progress.
• Use only laser print media. Do not use ink jet paper in your printer.

1 Pull the tray out of the printer about 200 mm. Hold the tray with both hands, and remove it from 
the printer.

2 Adjust the paper guides.

NOTE: 
• Extend the rear side of the tray when you load Legal size paper.

3 Before loading the print media, flex the sheets and fan them. Straighten the edges of the stack on 
a level surface.
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4 Load the print media into the tray with the recommended print side facing up.

NOTE: 
• Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.
• When loading coated paper, load coated paper one sheet at a time.

5 Align the width guides against the edges of the paper.

NOTE: 
• When loading user-specified print media, adjust the width guides and slide the extendable part of the tray 

by pinching the length guide and sliding it until it rests lightly against the edge of the paper.

6 After confirming that the guides are securely adjusted, insert the tray into the printer.

7 On the operator panel, select the desired paper size, and then press the  button.

8 Select the desired paper type, and then press the  button.
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Loading Envelope in the Standard 250-Sheet Tray
Use the following guidelines when loading envelopes in the standard 250-sheet tray:

NOTE: 
• If you do not load envelopes in the standard 250-sheet tray right after they have been removed from the 

packaging, they may bulge. To avoid jams, flatten them as shown below before loading the envelopes in the 
tray.

• Com-10 
Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps 
come at the right when you face towards the printer.
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• Monarch or DL
The Monarch or DL envelopes can be loaded in one of the following ways:
Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps 
come at the right when you face towards the printer.

OR
Load the envelopes long edge feed with the flaps open and the print side up. Ensure that the flaps 
come at the top when you face towards the printer.

• C5
Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps 
come at the bottom when you face towards the printer.
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Loading Letterhead in the Standard 250-Sheet Tray and the 
Optional 250-Sheet Feeder
When you use the standard 250-sheet tray and optional 250-sheet feeder, letterhead and hole 
punched paper enter the printer with the print side facing up.
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Loading Print Media in the Single Sheet Feeder (SSF)
1 Adjust the width guides to the print media's width.

2 Hold both sides of the print media face down close to the SSF, and push it 8 cm to 9 cm (4 
inches) into the printer until it automatically feeds.

NOTE: 
• Do not force the print media into the SSF.
• Load letterhead face down, with the top of the sheet entering the printer first.
• If you experience problems with paper feed, turn the paper around.



111 Printing Basics

Loading Envelope in the Single Sheet Feeder (SSF)

• Com-10, Monarch, or DL
To load an envelope into the SSF, insert the envelope short edge feed with the flap closed and the 
print side down. Ensure that the flap comes at the right when you face towards the printer. 

IMPORTANT: 
• Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and can 

cause damage to the printer.

NOTE: 
• Ensure that you load an envelope with the flap completely closed.
• Insert an envelope with the flap side face up and with the stamp area on the top right side.
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• C5
To load an envelope into the SSF, insert the envelope short edge feed with the flap open and the print 
side down. Ensure that the flap comes at the bottom when you face towards the printer. 

OR

IMPORTANT: 
• Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and can 

cause damage to the printer.

NOTE: 
• Ensure that you load an envelope with the flap completely opened.
• Insert an envelope with the flap side face up and with the stamp area on the bottom right side.

Loading Letterhead in the Single Sheet Feeder (SSF)
When you use the SSF letterhead enters the printer first with the print side facing down.
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Using the Single Sheet Feeder (SSF)
• Load only one size and type of print media during a single print job.
• To achieve the best possible print quality, use only high-quality print media that is designed for 

use in laser printer. For more guidelines on print media, see "Print Media Usage Guidelines" on 
page 95.

• Do not add or remove print media when the printer is printing from the SSF. This may result in a 
paper jam.

• Print media should be loaded with the recommended print side down and the top of the print 
media going into the SSF first.

• Do not place objects on the SSF. Also, avoid pressing down or applying excessive force on it.
• The icons on the SSF show how to load the SSF with paper, and how to turn an envelope for 

printing.
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Setting Paper Sizes and Types
When loading print media in the standard 250-sheet tray and optional 250-sheet feeder, set the paper 
size and type on the operator panel before printing.

NOTE: 
• When loading print media in the SSF, use the print driver to set the paper size and type. For more information, 

refer to the online help of the driver.

This section describes how to set the paper size and type on the operator panel.

See also: 
• "Understanding the Printer Menus" on page 142

This section includes:
• "Setting Paper Sizes" on page 115
• "Setting Paper Types" on page 116
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Setting Paper Sizes
1 On the operator panel, press the Menu button.

2 Select Tray Settings, and then press the  button.

3 Select Tray 1 or Tray 2, and then press the  button.

4 Select Paper Size, and then press the  button.

5 Select the correct paper size for the print media loaded, and then press the  button.
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Setting Paper Types
IMPORTANT: 
• Paper type settings must match those of the actual print media loaded in the tray or the feeder. Otherwise, 

print-quality problems can occur.

1 On the operator panel, press the Menu button.

2 Select Tray Settings, and then press the  button.

3 Select Tray 1 or Tray 2, and then press the  button.

4 Select Paper Type, and then press the  button.

5 Select the correct paper type for the print media loaded, and then press the  button.
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Printing
This section covers how to print certain lists of information from your printer and how to cancel a job.
This section includes:

• "Sending a Job to Print" on page 118
• "Canceling a Print Job" on page 119
• "Using the Stored Print Function" on page 120
• "Printing PDF Files Using PDF Bridge (Windows Only)" on page 122
• "Selecting Printing Options" on page 126
• "Printing Custom Size Paper" on page 132
• "Auditron" on page 134
• "Checking Status of Print Data" on page 135
• "Printing a Report Page" on page 136
• "Printer Settings" on page 137
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Sending a Job to Print
To support all of the printer features, use the print driver. When you choose Print from a software 
program, a window representing the print driver opens. Select the appropriate settings for the specific 
job that you are sending to print. Print settings selected from the driver override the default menu 
settings selected from the operator panel.
You may need to click Preferences from the initial Print box to see all of the available system settings 
you can change. If you are not familiar with a feature in the print driver window, open the online Help 
for more information.
To print a job from a typical Microsoft® Windows® application:

1 Open the file you want to print.

2 From the File menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the system settings as 
appropriate (such as the pages you want to print or the number of copies).

4 Click Preferences to adjust system settings that are not available from the first screen, and then 
click OK. 

5 Click OK or Print to send the job to the selected printer.
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Canceling a Print Job
There are several methods for canceling a job.
This section includes:

• "Canceling a Job From the Operator Panel" on page 119
• "Canceling a Job From the Computer Running Windows" on page 119

Canceling a Job From the Operator Panel
To cancel a job after it has started printing:

1 Press the Stop button.

2 From Active Jobs, select Print, and then press the Stop button.
Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Job From the Computer Running Windows

• Canceling a Job From the Taskbar
When you send a job to print, a small printer icon appears in the bottom right corner of the taskbar.

1 Double-click the printer icon. 
A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press Delete key on the keyboard.

• Canceling a Job From the Desktop

1 Click start → Printers and Faxes (for Windows XP).
Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printers (for Windows Server 2008).

2 Double-click the printer that you selected when you sent the job for print.
A list of print jobs appears in the printer window.

3 Select the job you want to cancel.

4 Press Delete key on the keyboard.
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Using the Stored Print Function
When you send a job to the printer, you can specify in the driver that you want the printer to store the 
job in the memory. When you are ready to print the job, go to the printer and use the operator panel 
menus to identify which job in the memory you want to print.
The stored print function includes the following job types:
• Secure Print
• Sample Print

NOTE: 
• Stored Print function is available when:

- The optional memory module is installed.
- The RAM disk is enabled in the operator panel menu.
- RAM Disk is set to Available in the print driver.

• The data in memory is cleared when the printer is turned off.

Secure Print
You can store print jobs temporarily in printer memory and print them later from the operator panel. 
This feature can be used to print confidential documents. A stored print job will be deleted after you 
print it or at a designated time.

NOTE: 
• Secure Print is available when you use the PCL driver.
• Secure Print requires specifying a password for confidentiality.

Sample Print
When you specify multiple copies for a collated job, this feature allows you to print only the first set for 
checking, before proceeding to print the remaining copies at the printer. You can select whether the 
remaining data is printed or deleted.

NOTE: 
• If a print job is too large for the memory available, the print may display error messages.
• If a document name is not assigned to your print job in the print driver, the job's name will be identified using 

the printer's time and date of submission to distinguish it from other jobs you have stored under your name.
• Sample Print is available when you use the PCL driver.

Storing Print Jobs
In the print driver, you can specify a setting that enables you to store print jobs in temporary memory. 
For example, select a job type other than Normal Print in the Paper / Output tab of the PCL 6 driver. 
The job will be stored in temporary memory until you request to print it from the operator panel or turn 
off the printer.
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Printing the Stored Jobs
Once jobs are stored, you can use the operator panel to specify printing. Select the job type you are 
using from Secure Print and Sample Print. Then, select your user ID from a list. Secure Print requires 
the password you specified in the driver when you sent the job. 
To print the stored documents, use the procedure below.

1 Press the  button.

2 Select Secure Print or Sample Print, and then press the  button.

3 Select your user ID, and then press the  button.

4 Select the document you want to print, and then press the  button.

5 Select the desired job type, and then press the  button.

6 Select Use PC Settings or Input Number, and then press the  button.

NOTE: 
• When you select Input Number, you can specify the number of copies to be printed before pressing 

the  button.
The stored document will be printed.

Specifying Your Password on the Operator Panel (Secure Print)
When you select your user ID for Secure Print, the following prompt appears:

Use the buttons on the operator panel to enter the numeric password you specified in the print driver. 
The password you entered will be displayed as asterisks (*******) to ensure confidentiality.
If you enter an invalid password, the message "Wrong password Re-enter" appears. Wait three 
seconds, or press the  button to return to the screen for user selection.
When you enter a valid password, you have access to all print jobs matching the user name and 
password you entered. The print jobs matching the password you entered appear on the screen. You 
can then choose to print or to delete jobs matching the password you entered. (See "Printing the 
Stored Jobs" for more information.)

Deleting Stored Jobs
With Secure Print, a job that has been stored will be deleted after printing if entered on the operator 
panel or at turning off the printer.
For Sample Print, these jobs remain stored until you delete them on the operator panel or turn off the 
printer.

[_           ]
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Printing PDF Files Using PDF Bridge (Windows Only)
The printer has the PDF Bridge feature, which enables you to print PDF files directly without a print 
driver. Printing PDF files without a print driver is much easier and faster when compared to printing 
with a print driver. This section describes how to print PDF files using PDF Bridge.
This section includes:

• "Supported PDF Files" on page 122
• "Using the ContentsBridge Utility" on page 122
• "Using the Commands" on page 123

Supported PDF Files
PDF files created on the following versions of Adobe Acrobat can be printed using PDF Bridge.

• Adobe Acrobat 5.X (excluding some of the features added to PDF1.4)
• Adobe Acrobat 6.X (excluding some of the features added to PDF1.5)
• Adobe Acrobat 7.X (excluding some of the features added to PDF1.6)

NOTE: 
• Some PDF files cannot be printed depending on how they are created. In such case, open the files and print 

them using a print driver.

Using the ContentsBridge Utility
The ContentsBridge Utility is software that enables direct printing of PDF files by simply dragging and 
dropping files onto the icon. To use the ContentsBridge Utility, refer to the manual included on the 
Driver CD Kit.
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Using the Commands
You can also print PDF files using the lpr or ftp command. When you print using these commands, the 
following PDF settings on the operator panel become effective.

• Quantity
• 2-Sided Print
• Print Mode
• Password
• Collated
• Output Size
• Layout
• Output Color

NOTE: 
• When you print using the lpr command, the print quantity must be set also using lpr command. In such case, 

the Quantity setting on the operator panel becomes invalid. If you do not specify the quantity using the lpr 
command, the printer recognizes the quantity as "1 set".

• To print PDF files using the lpr or ftp command, you must enable the printer's LPD or FTP port using the 
operator panel or CentreWare Internet Services (default: Enable).

Using the lpr command
In the command prompt, enter the lpr command as described in the following example:
Example: Printing "event.pdf" when the printer's IP address is 192.168.1.100.

Using the ftp command
In the command prompt, enter the ftp command as described in the following example:
Example: Printing "event.pdf" when the printer's IP address is 192.168.1.100.

C:\> lpr -S 192.168.1.100 -P lp event.pdf

C:\> ftp 192.168.1.100
Connected to 192.168.1.100.
220 FUJI XEROX DocuPrint XXXX

User (192.168.1.100:(none)):

331 Password required
Password:

230 Logged in

ftp> bin
200 Command successful

ftp> put event.pdf
200 Command successful
150 Opening data connection

226 Transfer complete

ftp: xxxxx bytes sent in xxxSeconds 
xxxxxkbytes/sec.

ftp>
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Duplex Printing
This section includes:

• "Automatic Duplex Printing" on page 124
• "Using Booklet Print" on page 125

Automatic Duplex Printing
Automatic duplex printing (or 2-sided printing) allows you to print on both sides of a sheet of paper. A4, 
Letter, Folio, and Legal paper sizes are acceptable.
The following procedure uses the PCL 6 driver as an example.

1 Click start → Printers and Faxes (for Windows XP).
Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printers (for Windows Server 2008).

A list of available printers appears. 

2 Right-click the printer and select Printing Preferences.
The Paper / Output tab appears.

3 From Paper Tray, select Tray1, Tray2, or Auto Paper Select.

4 From 2 Sided Print, select 2 Sided Print or 2 Sided, Flip on Short Edge.

NOTE: 
• For details on the 2 Sided Print and 2 Sided, Flip on Short Edge options, see "2 Sided Print" on 

page 125 and "2 Sided, Flip on Short Edge" on page 125.

5 Click OK.
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Using Booklet Print
To use the Booklet Print feature, select Booklet Creation in the Booklet / Poster / Mixed 
Document / Rotation dialog box displayed by clicking the Booklet / Poster / Mixed Document / 
Rotation button in the Layout tab of the printer printing preferences dialog box. 2 Sided Print binding 
position is selected by default. If you want to change the position, select 2 Sided, Flip on Short Edge 
from the 2 Sided Print menu in the Paper / Output tab of the printer printing preferences dialog box.

NOTE: 
• To use the booklet printing, select Tray1, Tray2, or Auto Paper Select for Paper Tray in the Paper / Output 

tab. Do not select Manual Feeder.

2 Sided Print Assumes binding along the long edge of the page (left edge 
for portrait orientation and top edge for landscape 
orientation). The following illustration shows long-edge 
binding for portrait and landscape pages:

2 Sided, Flip on 
Short Edge

Assumes binding along the short edge of the page (top 
edge for portrait orientation and left edge for landscape 
orientation). The following illustration shows short-edge 
binding for portrait and landscape pages:

Portrait Landscape

Portrait Landscape
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Selecting Printing Options
This section includes:

• "Selecting Printing Preferences (Windows)" on page 126
• "Selecting Options for an Individual Job (Windows)" on page 127
• "Selecting Options for an Individual Job (Mac OS X)" on page 130

Selecting Printing Preferences (Windows)
Printer preferences control all of your print jobs, unless you override them specifically for a job. For 
example, if you want to use duplex printing for most jobs, set this option in printer settings.
The following procedure uses the PCL 6 driver as an example.
To select printer preferences:

1 Click start → Printers and Faxes (for Windows XP).
Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printers (for Windows Server 2008).

A list of available printers appears. 

2 Right-click the icon for your printer, and then select Printing Preferences.
The FX DocuPrint CP305 d PCL 6 Printing Preferences screen appears.

3 Select the Advanced Settings tab, and then click Defaults.

4 Make selections on the driver tabs, and then click OK to save your selections.

NOTE: 
• For more information about Windows print driver options, click Help on the print driver tab to view the online 

help.
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Selecting Options for an Individual Job (Windows)
If you want to use special printing options for a particular job, change the driver settings before 
sending the job to the printer. For example, if you want to use Photo print-quality mode for a particular 
graphic, select this setting in the driver before printing that job.
The following procedure uses the PCL 6 driver as an example.

1 With the desired document or graphic open in your application, access the Print dialog box.

2 Select the FX DocuPrint CP305 d PCL 6 and click Preferences to open the print driver.

3 Make selections on the driver tabs. See the following table for specific printing options.

NOTE: 
• In Windows XP, Windows Server 2003, Windows Server 2008, Windows Vista, Windows Server 2008 

R2, and Windows 7, you can save current printing options with a distinctive name and apply them to 
other print jobs. Select either the Paper / Output, Image Options, Layout, Watermarks / Forms, or 
Advanced Settings tab, and then click Save on the Paper / Output tab. Click Help for more 
information.

4 Click OK to save your selections.

5 Print the job.
See the following table for specific printing options:
The table shown below uses the PCL 6 driver as an example.

Printing Options for Windows
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Operating System Driver Tab Printing Options
Windows XP, Windows XP 
x 64bit, Windows Server 
2003, Windows Server 
2003 x 64bit, Windows 
Vista, Windows Vista x 
64bit, Windows Server 
2008, Windows Server 
2008 x 64bit, Windows 
Server 2008 R2, Windows 
7, or Windows 7 x 64bit

Paper / Output tab • Job Type
• Saved Settings
• 2 Sided Print
• Output Color
• Quantity
• Paper Summary
• Paper Size
• Paper Tray
• Paper Type
• Manual Feeder Feed Orientation
• Covers / Separators
• Envelope/Paper Setup Wizard
• Printer Status
• Defaults

Image Options tab • Output Color
• Image Quality
• Output Recognition
• Image Adjustment Mode
• Image Types
• Image Auto Correction
• Image Settings
• Color Balance
• Profile Settings
• Defaults

Layout tab • Image Orientation
• Multiple-Up
• Booklet / Poster / Mixed Document / Rotation
• Fit to New Paper Size
• Specify Zoom
• Image Shift / Print Position
• Defaults
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Windows XP, Windows 
Server 2003, Windows 
Vista, Windows Server 
2008, or Windows 7

Watermarks / Forms tab • Watermarks
– New Watermark
– New Watermark (Bitmap)
– Edit Watermark
– Delete Watermark
– Apply to First Page Only

• Forms
– No Forms
– Create / Register Forms
– Image Overlay

• Annotation
• Defaults

Windows XP, Windows XP 
x 64bit, Windows Server 
2003, Windows Server 
2003 x 64bit, Windows 
Vista, Windows Vista x 
64bit, Windows Server 
2008, Windows Server 
2008 x 64bit, Windows 
Server 2008 R2, Windows 
7, or Windows 7 x 64bit

Advanced Settings tab • Skip Blank Pages
• Draft Mode
• Banner Sheet
• Substitute Tray
• Other Settings (Graphics Settings)

– Items
– Settings for
– Paper Tray Selection Method

• Specify Font
• About
• Defaults

Operating System Driver Tab Printing Options
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Selecting Options for an Individual Job (Mac OS X)
To select print settings for a particular job, change the driver settings before sending the job to the 
printer.

1 With the document open in your application, click File, and then click Print.

2 Select the desired printing options from the menus and drop-down lists that are displayed.

NOTE: 
• In Mac OS® X, click Save as on the Presets menu screen to save the current printer settings. You can 

create multiple presets and save each with its own distinctive name and printer settings. To print jobs 
using specific printer settings, click the applicable saved preset in the Presets list.

3 Click Print to print the job.
Mac OS X Print Driver Printing Options:
The table shown below uses Mac OS X 10.6 TextEdit as an example.

Printing options for Mac OS X

Item Printing Options
• Copies
• Collated
• Pages
• Paper Size
• Orientation

Layout • Pages per Sheet
• Layout Direction
• Border
• Two-Sided

Color Matching • ColorSync
• Profile

Paper Handling • Pages to Print
• Page Order
• Destination Paper Size

Paper Feed • All pages From
• First Pages From
• Remaining From

Cover Page • Print Cover Page
• Cover Page Type
• Billing Info

Scheduler • Print Document
• Priority

Job Accounting • Account Mode
• User Details Setup

Job Type • Job Type
• Setup
• Defaults
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Image Options • Output Color
• Image Quality
• Brightness
• Basic Features/Advanced Features
• Image Type
• Image Adjustment
• Screen
• Color Balance
• Defaults

Printer Features • Feature Sets
• Gray Guaranteed
• Feed Orientation
• Paper Type
• Substitute Tray
• Custom Paper Auto Orientation
• Image Enhancement
• Draft Mode
• Skip Blank Pages
• Halftone Screen Lock
• High speed for monochrome documents
• Trapping
• Letterhead Duplex Mode

Summary

Item Printing Options
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Printing Custom Size Paper
This section explains how to print on custom size paper using the print driver.
Custom size paper can be loaded in the SSF and standard 250-sheet tray. The way to load custom 
size paper in the SSF is the same as the one to load standard size paper. The way to load custom size 
paper in the standard 250-sheet tray is the same as the one to load standard size paper.

NOTE: 
• Custom size paper cannot be loaded in the optional 250-sheet feeder.

See also: 
• "Loading Print Media in the Single Sheet Feeder (SSF)" on page 110
• "Loading Print Media in the Standard 250-Sheet Tray and the Optional 250-Sheet Feeder" on page 105
• "Setting Paper Sizes and Types" on page 114

Defining Custom Paper Sizes
Before printing, set the custom size on the print driver.

NOTE: 
• When setting the paper size on the print driver and the operator panel, be sure to specify the same size as the 

actual print media used. Setting the wrong size for printing can cause printer failure. This is especially true if 
you configure a bigger size when using a narrow width paper.

• Using the Windows Print Driver
On the Windows print driver, set the custom size in the Custom Paper Size dialog box. This section 
explains the procedure using Windows XP and the PCL 6 driver as an example.
For Windows XP or later, an administrator’s password only allows users with administrator rights to 
change the settings. Users without the rights of administrator can only view the contents.

1 Click start → Printers and Faxes.

2 Right-click the printer, and then select Properties.

3 Select the Configuration tab.

4 Click Custom Paper Size.

5 Select the custom setup you want to define from Details.

6 Specify the length of the short edge and long edge under Settings for. You can specify the 
values either by entering them directly or using the Up Arrow and Down Arrow buttons. The 
length of the short edge cannot be longer than the long edge, even if it is within the specified 
range. The length of the long edge cannot be shorter than the short edge, even if it is within the 
specified range.

7 To assign a paper name, select the Name Paper Size check box, and then enter the name in 
Paper Name. Up to 14 characters can be used for the paper name.

8 If necessary, repeat steps 5 to 7 to define another custom size.

9 Click OK twice.
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Printing on Custom Size Paper
Use the following procedures to print using either the Windows or Mac OS X print drivers.

• Using the Windows Print Driver
To print on custom size paper using the PCL 6 driver as an example:

NOTE: 
• The way to display the printer Properties dialog box differs according to the application software. Refer to the 

manual of each application software.

1 From the File menu, select Print.

2 Select the printer as the printer to be used and click Preferences.

3 Select the Paper / Output tab.

4 Select the size of the original document from Paper Size.

5 Select the appropriate paper type from Paper Type.

6 Click the Layout tab.

7 From Fit to New Paper Size, select Same as Paper Size.

8 Click OK.

9 Click Print in the Printer dialog box to start printing.

• Using the Mac OS X Print Driver
This section explains the procedure using Mac OS X 10.6 TextEdit as an example.

1 From the File menu, select Page Setup.

2 Select the printer as the printer to be used from Format For.

3 From Paper Size, select Manage Custom Sizes.

4 In the Custom Page Sizes window, click +.
A newly created setting “Untitled” is displayed in the list.

5 Double-click "Untitled" and enter the name for the setting.

6 Enter the size of the original document in the Width and Height boxes of Paper Size.

7 Specify Non-Printable Area if necessary.

8 Click OK.

9 From the File menu, select Print.

10 Click Print in the Print dialog box to start printing.
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Auditron
Auditron contains an authentication function that can set limits on what processes can be used, as 
well as an account management that can be used to control usage based on authentication.
The following illustration shows how the printer works with Auditron. 

Registererd user A
Registererd user B

Can print up to 
10,000 pages in 
black and white

Print account report

Normal user D System administrator C

Can print up to 10,000 
pages in color or black 
and white

Cannot print if not a 
registered user, or if the 
printed pages exceeds the 
limit

Reference account report 
for each registered user
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Checking Status of Print Data
This section includes:

• "Checking Status (Windows Only)" on page 135
• "Checking Status in CentreWare Internet Services (Windows & Mac OS X)" on page 135

Checking Status (Windows Only)
Printer information and status are displayed on the SimpleMonitor window. Double-click the 
SimpleMonitor printer icon on the taskbar at the bottom right of the screen. From the displayed 
window, check the column Status.
You can change the display contents with the button on the left of the SimpleMonitor window.
Status Settings button: Displays the Status Settings dialog box and allows you to check the printer 
name, printer connection port, and printer status.
For more information about SimpleMonitor, see Help: The following procedure uses Windows XP as 
an example:

1 Click start → All Programs.

2 Select Fuji Xerox.

3 Select SimpleMonitor for Asia-Pacific.

4 Select SimpleMonitor Help.

See also: 
• "SimpleMonitor (Windows Only)" on page 55

Checking Status in CentreWare Internet Services (Windows & Mac 
OS X)
You can check the status of the print job sent to the printer at the Status tab of CentreWare Internet 
Services.

See also: 
• "Printer Management Software" on page 51
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Printing a Report Page
You can print a variety of settings for your printer including printer settings, panel settings, job history, 
error history, print meter, font list, macro list, stored document list, and demo page. This section 
describes how to print a report page.

Printing a Printer Settings Page
To verify detailed printer settings, print a printer settings page. A printed printer settings page also 
allows you to verify whether or not options have been installed properly.

See also: 
• "Understanding the Printer Menus" on page 142

1 Press the Menu button.

2 Select Report/List, and then press the  button.

3 Select Printer Settings, and then press the  button.
The printer settings page is printed.

If any message appears when you print this page, see the online Help for more information.
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Printer Settings
You can select menu items and corresponding values from the operator panel.
When you first browse through the menus from the operator panel, you see some menu items marked 
with an asterisk (*).
These items are the factory default and original system settings.

NOTE: 
• Factory defaults may vary for different countries.

When you select a new setting from the operator panel, the item selected is marked with an asterisk 
(*) to identify it as the current user default menu setting.
These settings are active until new ones are selected or the factory defaults are restored.
To select a new value as a setting:

1 Press the Menu button.

2 Select the desired menu, and then press the  button.

3 Select the desired menu or menu item, and then press the  button.
• If the selection is a menu, the menu is opened and the first system setting in the menu 

appears.
• If the selection is a menu item, the default menu setting for the menu item appears. (The 

current user default menu setting is marked with an asterisk (*).)
Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting
• A numerical value that can be changed
• An On or Off setting

4 Select the desired value, and then press the  button.

5 Press the  (Back) or  button to return to the previous menu.
To continue setting other items, select the desired menu. To quit setting new values, press the 

 (Back) button.

Driver settings may override changes previously made and may require you to change the operator 
panel defaults.
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Printing With Web Services on Devices (WSD)
This section provides information for network printing with WSD, the new Microsoft protocol for 
Microsoft Windows Vista, Windows Server 2008, Windows Server 2008 R2, and Windows 7.
This section includes:

• "Adding Roles of Print Services" on page 139
• "Printer Setup" on page 140
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Adding Roles of Print Services
When you use Windows Server 2008 or Windows Server 2008 R2, you need to add the roles of print 
services to the Windows Server 2008 or Windows Server 2008 R2 client.

• For Windows Server 2008:

1 Click Start→ Administrative Tools→ Server Manager.

2 Select Add Roles from the Action menu.

3 Select the Print Services check box on the Server Roles window in the Add Roles Wizard, and 
then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.

• For Windows Server 2008 R2:

1 Click Start→ Administrative Tools→ Server Manager.

2 Select Add Roles from the Action menu.

3 Select the Print and Document Services check box on the Server Roles window in the Add 
Roles Wizard, and then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.
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Printer Setup
You can install your new printer on the network using the Driver CD Kit that shipped with your printer, 
or using Microsoft Windows’ Add Printer wizard. The following procedure uses the PCL 6 driver as an 
example.

Installing a Print Driver Using the Add Printer Wizard

1 Click Start→ Control Panel→ Hardware and Sound→ Printers (Start→ Devices and Printers 
for Windows Server 2008 R2 and Windows 7).

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer.

4 In the list of available printers, select the one you want to use, and then click Next.

NOTE: 
• In the list of available printers, the WSD printer is displayed in the form of http://IP address/ws/.
• If no WSD printer is displayed in the list, enter the printer's IP address manually to create a WSD printer. 

To enter the printer's IP address manually, follow the instructions below.
For Windows Server 2008 R2, to create a WSD printer, you must be a member of Administrators group.
1 Click The printer that I want isn't listed. 
2 Select Add a printer using a TCP/IP address or hostname and click Next. 
3 Select Web Services Device from Device type.
4 Enter the printer's IP address in Hostname or IP address and click Next.

• Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, 
perform one of the following:
- Establish the Internet connection so that Windows Update can scan your computer.
- Add the print driver to your computer.

5 If prompted, install the print driver on your computer. If you are prompted for an administrator 
password or confirmation, enter the password or provide confirmation.

6 Complete the additional steps in the wizard, and then click Finish.

7 Print a test page to verify print installation.
a Click Start→ Control Panel→ Hardware and Sound→ Printers (Start→ Devices and 

Printers for Windows Server 2008 R2 and Windows 7).
b Right-click the printer you just created, and then click Properties (Printer properties for 

Windows Server 2008 R2 and Windows 7).
On the Options tab, set each setting item, and then click Apply.

c On the General tab, click Print Test Page. When a test page prints successfully, installation 
is complete.
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6
Using the Operator Panel Menus

This chapter includes:
• "Understanding the Printer Menus" on page 142
• "Panel Lock Function" on page 173
• "Setting the Power Saver Time Option" on page 176
• "Resetting to Factory Defaults" on page 177
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Understanding the Printer Menus
When your printer is connected to a network and available to a number of users, the access to the 
Admin Menu can be limited. This prevents other users from using the operator panel to inadvertently 
change a user default that has been set by the administrator. 
However, you can use your print driver to override user defaults and select settings for individual print 
jobs.
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Report/List
Use the Report/List menu to print various types of reports and lists.

Printer Settings
Purpose:
To print a list of the current user default values, the installed options, the amount of installed print 
memory, and the status of printer supplies.

Panel Settings
Purpose:
To print a detailed list of all the settings on the operator panel menus.

PCL Fonts List
Purpose:
To print a sample of the available PCL fonts.

PCL Macro List
Purpose:
To print the information on the downloaded PCL macro.

PS Fonts List
Purpose:
To print a sample of the available PS fonts.

PDF Fonts List
Purpose:
To print a sample of the available PDF fonts.

Job History
Purpose:
To print a detailed list of the print jobs that have been processed. This list contains the last 20 jobs.

Error History
Purpose:
To print a detailed list of paper jams and fatal errors.

Print Meter
Purpose:
To print the reports for the total number of pages printed.
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Demo Page
Purpose:
To print a page for testing colors.

Stored Documents
NOTE: 
• Stored Documents feature is available only when the 512 MB optional memory module is installed on the 

printer and RAM Disk under System Settings is enabled.

Purpose:
To print a list of all files stored for Secure Print and Sample Print in the RAM disk.
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Meter Readings
Purpose:
To check the total number of printed pages.
Values:

Meter 1 Displays the total number of color prints.

Meter 2 Displays the total number of monochrome prints.

Meter 3 Displays the total number of large size color prints. 

Meter 4 Displays the total number of color and monochrome prints (Meter 1 + 
Meter 2).
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Admin Menu
Use the Admin Menu menu to configure a variety of printer features.

PCL Settings
Use the PCL Settings menu to change printer settings that only affect jobs using the PCL emulation 
printer language.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Paper Tray
Purpose:
To specify the default paper tray.
Values:

Auto*

Tray 1
Tray 2*1

Manual Feed
*1 Tray 2 is available only 

when the optional 250-sheet 
feeder is installed.
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• Output Size
Purpose:
To specify the default paper size.
Values:

mm series

inch series

NOTE: 
• Selecting a custom size for the paper size prompts you to enter a custom length and width.

A4 - 210x297*1

A5 - 148x210
B5 - 182x257
Letter - 8.5x11
US Folio-8.5x13
Legal - 8.5x14
Executive
Monarch Env.
DL Env - 110x220
C5 Env - 162x229
#10Env - 4.1x9.5
New Custom Size Portrait (Y) 297 mm* Specifies the length of 

the custom size paper.127 - 355 mm

Landscape (X) 210 mm* Specifies the width of 
the custom size paper.77 - 215 mm

*1 The default for Output Size varies depending on country-specific factory.

Letter - 8.5x11*1

US Folio-8.5x13
Legal - 8.5x14
A4 - 210x297
A5 - 148x210
B5 - 182x257
Executive
Monarch Env.
DL Env- 110x220
C5 Env- 162x229
#10Env- 4.1x9.5
New Custom Size Portrait (Y) 11.7 inch* Specifies the length of 

the custom size paper.5.0-14.0 inches

Landscape (X) 8.3 inch* Specifies the width of 
the custom size paper.3.0-8.5 inches

*1 The default for Output Size varies depending on country-specific factory.
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• Orientation
Purpose:
To specify how text and graphics are oriented on the page.
Values:

• 2-Sided
Purpose:
To specify whether to print on both sides of a sheet of paper.
Values:

• Font
Purpose:
To specify the default font from the fonts registered in the printer.
Values:

Portrait* Prints text and graphics parallel to the short edge of the paper.

Landscape Prints text and graphics parallel to the long edge of the paper.

2-Sided Print Off* Does not print on both sides of a sheet of paper.

On Prints on both sides of a sheet of paper.

Binding Edge Long Edge Flip* Prints on both sides of a sheet of paper to be bound by long 
edge.

Short Edge Flip Prints on both sides of a sheet of paper to be bound by short 
edge.

CG Times LetterGothic CourierPS
CG Times It LetterGothic It CourierPS Ob
CG Times Bd LetterGothic Bd CourierPS Bd
CG Times BdIt Albertus Md CourierPS BdOb
Univers Md Albertus XBd SymbolPS
Univers MdIt Clarendon Cd Palatino Roman
Univers Bd Coronet Palatino It
Univers BdIt Marigold Palatino Bd
Univers MdCd Arial Palatino BdIt
Univers MdCdIt Arial It ITCBookman Lt
Univers BdCd Arial Bd ITCBookman LtIt
Univers BdCdIt Arial BdIt ITCBookmanDm
AntiqueOlv Times New ITCBookmanDm It
AntiqueOlv It Times New It HelveticaNr
AntiqueOlv Bd Times New Bd HelveticaNr Ob
CG Omega Times New BdIt HelveticaNr Bd
CG Omega It Symbol HelveticaNrBdOb
CG Omega Bd Wingdings N C Schbk Roman
CG Omega BdIt Line Printer N C Schbk It
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• Symbol Set
Purpose:
To specify a symbol set for a specified font.
Values:

• Font Size
Purpose:
To specify the font size for scalable typographic fonts, within the range of 4.00 to 50.00. The default is 
12.00.
Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an 
inch.

NOTE: 
• The Font Size menu is only displayed for typographic fonts.

GaramondAntiqua Times Roman N C Schbk Bd
Garamond Krsv Times It N C Schbk BdIt
Garamond Hlb Times Bd ITC A G Go Bk
GaramondKrsvHlb Times BdIt ITC A G Go BkOb
Courier* Helvetica ITC A G Go Dm
Courier It Helvetica Ob ITC A G Go DmOb
Courier Bd Helvetica Bd ZapfC MdIt
Courier BdIt Helvetica BdOb ZapfDingbats

ROMAN-8* WIN L1 ISO-6
ISO L1 WIN L2 ISO-11
ISO L2 WIN L5 ISO-15
ISO L5 DESKTOP ISO-17
ISO L6 PS TEXT ISO-21
PC-8 MC TEXT ISO-60
PC-8 DN MS PUB ISO-69
PC-775 MATH-8 WIN 3.0
PC-850 PS MATH WINBALT
PC-852 PI FONT SYMBOL
PC-1004 LEGAL WINGDINGS
PC-8 TK ISO-4 DNGBTSMS
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• Font Pitch
Purpose:
To specify the font pitch for scalable mono spaced fonts, within the range of 6.00 to 24.00. The default 
is 10.00.
Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For 
nonscheduled mono spaced fonts, the pitch is displayed, but cannot be changed.

NOTE: 
• The Font Pitch menu is only displayed for fixed or mono spaced fonts.

• Form Line
Purpose:
To set the number of lines in a page.
Values:

The printer sets the amount of space between each line (vertical line spacing) based on the Form 
Line and Orientation menu items. Select the correct Form Line and Orientation before 
changing Form Line.

• Quantity
Purpose:
To set the default print quantity, within the range of 1 to 999. The default is 1. (Set the number of 
copies required for a specific job from the print driver. Values selected from the print driver always 
override values selected from the operator panel.)

• Image Enhance
Purpose:
To specify whether to enable the Image Enhance feature, which makes the boundary line between 
black and white smoother to decrease jagged edges and enhance the visual appearance.
Values:

• Hex Dump
Purpose:
To help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer 
is printed in hexadecimal and character representation. Control codes are not executed.
Values:

64*1  (mm series)/60*1 (inch series) Sets the value in increments of 1.

5–128
*1 Denotes country-specific factory default values. 

Off Disables the Image Enhance feature.

On* Enables the Image Enhance feature.

Disable* Disables the Hex Dump feature.

Enable Enables the Hex Dump feature.
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• Draft Mode
Purpose:
To save toner by printing in the draft mode. The print quality is reduced when you print in the draft 
mode.
Values:

• LineTermination
Purpose:
To add the line termination commands.
Values:

• Output Color
Purpose:
To specify the color mode to Color or Black and White. This setting is used for a print job that 
does not specify a print mode.
Values:

PDF Settings
Use the PDF Settings menu to change printer settings that only affect the PDF jobs.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Quantity
Purpose:
To specify the number of copies to print.
Values:

Disable* Does not print in the draft mode.

Enable Prints in the draft mode.

Off* The line termination command is not added.

CR=CR, LF=LF, FF=FF

Add-LF The LF command is added.

CR=CR-LF, LF=LF, FF=FF

Add-CR The CR command is added.

CR=CR, LF=CR-LF, FF=CR-FF

CR-XX The CR and LF commands are added.

CR=CR-LF, LF=CR-LF, FF=CR-FF

Black and White* Prints in the black and white mode.

Color Prints in the color mode.

1 sets* Sets the value in increments of 1.

1–999
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• 2-Sided Print
Purpose:
To specify whether to print on both sides of a sheet of paper.
Values:

• Print Mode
Purpose:
To specify the print mode.
Values:

• Password
Purpose:
To specify the password to print the secure PDF. 
Value:

• Collated
Purpose:
To specify whether to sort the job.
Values:

• Output Size
Purpose:
To specify the output paper size for PDF.
Values:

1-Sided* Prints on one side of a sheet of paper.

Long Edge Flip Prints on both sides of a sheet of paper to be bound by long edge. 

Short Edge Flip Prints on both sides of a sheet of paper to be bound by short edge.

Normal* For documents with normal sized characters. 

High Quality For documents with small characters or thin lines, or documents 
printed using a dot-matrix printer.

High Speed Prints with the higher speed than the Normal mode, but the quality is 
less. 

Password Enter the password to print the secure PDF.

Off* Does not sort the job. 

On Sorts the job.

A4 - 210x297*1

Letter - 8.5x11*1

Auto
*1 The default paper size is 

displayed.
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• Layout
Purpose:
To specify the output layout.
Values:

• Output Color
Purpose:
To specify the output color.
Values:

PS Settings
Use the PS Settings menu to change printer settings that only affect jobs using the PostScript 
emulation printer language.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• PS Error Report
Purpose:
To specify whether to print the contents of PostScript errors.
Values:

• PS Job Time-out
Purpose:
To specify the runtime of one PostScript job.
Values:

Auto %*

100% (No Zoom)
Booklet
2 Pages Up
4 Pages Up

Color (Auto)*

Black and White

Off Dose not print the PS error report.

On* Prints the PS error report.

Off* Does not set the runtime of a PostScript job.

On 1 min. Sets the runtime of a PostScript job.

1-900 min.
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• Paper Select Mode
Purpose:
To set the way to select the paper tray for PostScript mode.
Values:

• Output Color
Purpose:
To set the default color for PostScript.
Values:

Wired Network
Use the Wired Network menu to change the printer settings affecting jobs sent to the printer 
through the wired network.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Ethernet
Purpose:
To specify the communication speed and the duplex settings of Ethernet. The change becomes 
effective after the printer is turned off and then on again.
Values:

• TCP/IP
Purpose:
To configure TCP/IP settings. 
Values:

Auto* Automatically selects the paper tray for PostScript mode.

Select FromTray Manually selects the paper tray for PostScript mode.

Color* Prints in color mode.

Black and White Prints in black and white mode.

Auto* Detects the Ethernet settings automatically.

10BASE-T Half Uses 10BASE-T Half-duplex.

10BASE- T Full Uses 10BASE-T Full-duplex.

100BASE- TX Half Uses 100BASE-TX Half-duplex.

100BASE- TX Full Uses 100BASE-TX Full-duplex.

1000BASE- T Full Uses 1000BASE-T Full-duplex.

IP Mode Dual Stack* Uses both IPv4 and IPv6 to set the IP address.

IPv4 Uses IPv4 to set the IP address.

IPv6 Uses IPv6 to set the IP address.
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• Protocol
Purpose:
To enable or disable each protocol. The change becomes effective after the printer is turned off and 
then on again.
Values:

IPv4 Get IP 
Address

DHCP / 
Autonet*

Sets the IP address automatically. A random value in the 
range of 169.254.1.0 to 169.254.254.255 that is not currently 
in use on the network is set as the IP address. The subnet 
mask is set as 255.255.0.0.

BOOTP Sets the IP address using BOOTP.

RARP Sets the IP address using RARP. 

DHCP Sets the IP address using DHCP.

Panel Use this option when you want to set the IP address manually 
on the operator panel.

IP Address When an IP address is being set manually, the IP is allocated 
to the printer using the format nnn.nnn.nnn.nnn. Each octet 
that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 
254. 127 and any value in the range of 224 to 254 cannot be 
specified for the first octet of a gateway address. 

Subnet Mask When an IP address is being set manually, the subnet mask is 
specified using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 
255.255.255.255 cannot be specified as the subnet mask.

Gateway Address When an IP address is being set manually, the gateway 
address is specified using the format nnn.nnn.nnn.nnn. Each 
octet that makes up nnn.nnn.nnn.nnn is a value in the range of 
0 to 254. 127 and any value in the range of 224 to 254 cannot 
be specified for the first octet of a gateway address. 

IPsec Disable* Disables IPsec.

LPD Disable Disables the Line Printer Daemon (LPD) port.

Enable* Enables the LPD port.

Port9100 Disable Disables the Port9100 port.

Enable* Enables the Port9100 port.

FTP Disable Disables the FTP port.

Enable* Enables the FTP port.

IPP Disable Disables IPP port.

Enable* Enables IPP port.

SMB (TCP/IP) Disable Disables SMB TCP/IP port.

Enable* Enables SMB TCP/IP port.

SMB (NetBEUI) Disable Disables SMB Net BEUI port.

Enable* Enables SMB Net BEUI port.

WSD Disable Disables WSD port.

Enable* Enables WSD port.

SNMP (UDP/IP) Disable Disables the Simple Network Management Protocol (SNMP) 
UDP port.

Enable* Enables the SNMP UDP port.
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• IP Filter
NOTE: 
• IP Filter feature is available only when Protocol is set to LPD or Port9100.

Purpose:
To block data received from certain IP addresses through the wired network. You can set up to five IP 
addresses. The change becomes effective after the printer is turned off and then on again.
Values:

• IEEE 802.1x
NOTE: 
• IEEE 802.1x feature is available only when the printer is connected using LAN cable and it is available only 

when the IEEE 802.1 authentication is enabled.

Purpose:
To disable IEEE 802.1x authentication. The change becomes effective after the printer is turned off 
and then on again.
Value:

• Initialize NVM
Purpose:
To initialize wired network data stored in non-volatile memory (NVM). After executing this function and 
rebooting the printer, all wired network settings are reset to their default values.

StatusMessenger Disable Disables the E-Mail Alert feature.

Enable* Enables the E-Mail Alert feature.

InternetServices Disable Disables an access to CentreWare Internet Services 
embedded in the printer.

Enable* Enables an access to CentreWare Internet Services 
embedded in the printer.

Bonjour(mDNS) Disable Disables Bonjour (mDNS).

Enable* Enables Bonjour (mDNS).

Telnet Disable* Disables Telnet.

Enable Enables Telnet.

HTTP-SSL/TLS Disable Disables HTTP-SSL/TLS.

Enable* Enables HTTP-SSL/TLS.

No. n / Address (n is 1–5.) Sets the IP address for Filter n.

No. n / Mask (n is 1–5.) Sets the address mask for Filter n.

No. n / Mode (n is 
1–5.)

Off* Disables the IP Filter feature for Filter n.

Accept Accepts an access from the specified IP address.

Reject Rejects an access from the specified IP address.

Disable Disables IEEE 802.1x.
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• Adobe Protocol
Purpose:
To set the PostScript communications protocol.
Values:

•

USB Settings
Use the USB Settings menu to change printer settings affecting a USB port.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Port Status
Purpose:
To specify whether to enable the USB port. The change becomes effective after the printer is turned 
off and then on again.
Values:

• Adobe Protocol
Purpose:
To set the PostScript communications protocol.
Values:

System Settings
Use System Settings to configure a variety of printer features.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

Auto* Sets the PostScript communications protocol automatically.

Standard Sets the PostScript communications protocol to Standard.

BCP Sets the PostScript communications protocol to BCP.

TBCP Sets the PostScript communications protocol to TBCP.

Binary Sets the PostScript communications protocol to Binary.

Disable Disables the USB interface.

Enable* Enables the USB interface.

Auto Sets the PostScript communications protocol automatically.

Standard Sets the PostScript communications protocol to Standard.

BCP Sets the PostScript communications protocol to BCP.

TBCP* Sets the PostScript communications protocol to TBCP.

Binary Sets the PostScript communications protocol to Binary.
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• Power Saver Time
Purpose:
To specify the time for transition to power saver mode.
Values:

Enter 5 to put the printer in power saver mode five minutes after it finishes a job. This uses much less 
energy, but requires more warm-up time for the printer. Enter 5 if your printer shares an electrical 
circuit with room lighting and you notice lights flickering.
Select a high value if your printer is in constant use. In most circumstances, this keeps the printer 
ready to operate with minimum warm-up time. Select a value between 5 and 30 minutes for power 
saver mode if you want a balance between energy consumption and a shorter warm-up period.
The printer automatically returns to the standby mode from the power saver mode when it receives 
data from the computer. You can also change the status of the printer to the standby mode by pressing 
the Energy Saver button on the operator panel.

• Auto Reset
Purpose:
To automatically reset the settings to the default settings and return to the standby mode after you do 
not specify any settings for the specified time.
Values:

• Fault Time-out
Purpose:
To specify the amount of time the printer waits before canceling a job that stops abnormally. The print 
job is cancelled if the time-out time is exceeded. 
Values:

Low Power 
Timer

3min* Specifies the time taken by the printer to enter Low Power mode after 
it finishes a job.3–60 min.

Sleep Timer 6min* Specifies the time taken by the printer to enter Sleep mode after it has 
entered Low Power mode.1–6 min.

45sec*

1min
2min
3min
4min

Off Disables the fault time-out.

On* 60sec* Sets the amount of time the printer waits before canceling a job that 
stops abnormally.3–300 sec.
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• Job Time-out
Purpose:
To specify the amount of time the printer waits for data to arrive from the computer. The print job is 
cancelled if the time-out time is exceeded.
Values:

• Clock Settings
Purpose:
To specify the date and time formats.
Values:

• Audio Tones
Purpose:
To configure settings for tones emitted by the printer during operation or when a warning message 
appears. 
Values:

Off Disables the job time-out.

On* 30sec* Sets the time the printer waits for data to arrive from the computer.

5–300 sec.

Set Date & Time Time Zone Sets the time zone. 

Set Date Sets the date depending on the Date Format settings.

Set Time Sets the time.

Date Format yy/mm/dd Sets the date format.

mm/dd/yy
dd/mm/yy*

Time Format 12H Sets the time in 12-hour format.

24H* Sets the time in 24-hour format.
*1 The default for Date Format varies depending on country-specific factory default.

Control Panel Off* Does not emit a tone when the operator panel input is correct.

On Emits a tone when the operator panel input is correct.

Invalid Key Off* Does not emit a tone when the operator panel input is incorrect.

On Emits a tone when the operator panel input is incorrect.

Machine Ready Off Does not emit a tone when the printer is ready to process a job.

On* Emits a tone when the printer is ready to process a job.

Job Completed Off Does not emit a tone when a job is complete.

On* Emits a tone when a job is complete.

Fault Tone Off Does not emit a tone when a job ends abnormally.

On* Emits a tone when a job ends abnormally.

Alert Tone Off Does not emit a tone when a problem occurs.

On* Emits a tone when a problem occurs.
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• mm / inch
Purpose:
To specify the default measurement unit displayed after the numeric value on the operator panel.
Values:

• DefaultPaperSize
Purpose:
To specify the default paper size.
Values:

• Auto Job History
Purpose:
To automatically print a job history report after every 20 jobs.
Values:

The Job History report can also be printed using the Report/List menu.

Out of Paper Off Does not emit a tone when the printer runs out of paper.

On* Emits a tone when the printer runs out of paper.

Low Toner Alert Off Does not emit a tone when a toner is low.

On* Emits a tone when a toner is low.

AutoClear Alert Off* Does not emit a tone 5 seconds before the printer performs auto 
clear.

On Emits a tone 5 seconds before the printer performs auto clear.

All Tones Off Disables all the alert tones.

On* Sets the volume of all the alert tones at once.

Millimeters (mm)* Selects millimeter as the default measurement unit.

Inches (") Selects inch as the default measurement unit.

NOTE: 
• The default for mm/inch varies depending on other settings, such as Country and Document 

Size.

A4 - 210x297
Letter - 8.5x11
NOTE: 
• The default for DefaultPaperSize varies 

depending on country-specific factory default.

Off* Does not automatically print a job history report.
On Automatically prints a job history report.
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• Print ID
Purpose:
To specify a location where the user ID is printed. 
Values:

NOTE: 
• When you print on DL size paper, a part of the user ID may not be printed correctly.

• Print Text
Purpose:
To specify whether the printer outputs PDL data, which is not supported by the printer, as text when 
the printer receives it. Text data is printed on A4 or Letter size paper.
Values:

• Banner Sheet
NOTE: 
• Banner Sheet feature is available only when the optional 250-sheet feeder is installed on the printer.

Purpose:
To specify the position of banner sheet, and also specify the tray in which the banner sheet is loaded. 
Values:

Off* Does not print the user ID.

Top Left Prints the user ID on the top left of the page.

Top Right Prints the user ID on the top right of the page.

Bottom Left Prints the user ID on the bottom left of the page.

Bottom Right Prints the user ID on the bottom right of the page.

Off Does not print the received data.

On* Prints the received data as text data.

Insert Position Off* Does not print the banner sheet.

Start Sheet Inserted before the first page of every job.

End Sheet Inserted after the last page of every job.

Start&End 
Sheet

Inserted before the first page of every job and after the last page of 
every job.

Select Tray Tray 1* The banner sheet is loaded in the standard 250-sheet tray.

Tray 2 The banner sheet is loaded in the optional 250-sheet feeder.
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• RAM Disk
NOTE: 
• RAM Disk feature is available only when the 512 MB optional memory module is installed on the printer.

Purpose:
To allocate memory to the RAM disk file system for the Secure Print and Sample Print features. The 
change becomes effective after the printer is turned off and then on again.
Values:

NOTE: 
• Restart your printer when you change the settings for the RAM Disk menu.

• Substitute Tray
Purpose:
Specifies whether to use paper of a different size when the paper that is loaded in the specified tray 
does not match the paper size settings for the current job.
Values:

• Auditron Mode
Purpose:
To specify whether to limit the functions that can be used per user by Auditron authentication.
Values:

• No Acct User Prt
Purpose:
To specify whether to permit the printing of data without authentication information.
Values:

Disable Does not allocate memory to the RAM disk file system. Secure Print 
and Sample Print jobs will abort and be recorded to the job log.

Enable* 300MB* Sets the allocation of memory to the RAM disk file system in 
increments of 50 MB.50-500MB

Off* No tray size substitute accepted.

Larger Size Substitutes paper of next largest size. When there is no larger paper 
size, the printer substitutes paper of nearest size.

Closest Size Substitutes paper of nearest size.

Off* Does not limit functions by Auditron authentication.

On Limits functions by Auditron authentication.

Off* Does not permit non-account user to print the data.

On Permits non-account user to print the data.
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• LetterH Dup Mode
Purpose:
To specify whether to print on both sides when you use letterhead.
Values:

• Low Toner Msg
Purpose:
To specify whether to show the alert message when the toner is low.
Values:

Maintenance Mode
Use the Maintenance Mode menu to initialize the NV (non-volatile) memory, configure the plain 
paper quality adjustment settings, and configure the security settings.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• F/W Version
Purpose:
To confirm the current F/W version.

• Adjust PaperType
Purpose:
To specify paper density settings.
Values:

Disable* Does not print on both sides of letterhead.

Enable Prints on both sides of letterhead.

Off Does not show the alert message when the toner is low.

On* Shows the alert message when the toner is low.

Plain Lightweight
Heavyweight*

Labels Lightweight
Heavyweight*
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• Adjust BTR
Purpose:
To specify the transfer roller voltage adjustment for each paper type.
The default settings may not give the best output on all paper types. If you see mottles on the print 
output, try to increase the voltage. If you see white spots on the print output, try to decrease the 
voltage.

NOTE: 
• The print quality changes depending on the setting values you select for this item.

Values:

• Adjust Fuser
Purpose:
To adjust the fusing temperature setting for each paper type.
The default settings may not give the best output on all paper types. When the printed paper has 
curled, try to lower the temperature. When the toner does not fuse on the paper properly, try to 
increase the temperature.

NOTE: 
• The print quality changes depending on the setting values you select for this item.

Values:

Plain 0*

-6 to +6
Light Card 0*

-6 to +6
Heavy Card 0*

-6 to +6
Envelope 0*

-6 to +6
Labels 0*

-6 to +6
LW Gloss Card 0*

-6 to +6
HW Gloss Card 0*

-6 to +6

Plain 0*

-6 to +6
Light Card 0*

-6 to +6
Heavy Card 0*

-6 to +6
Envelope 0*

-6 to +6
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• Auto Adjust Regi
Purpose: 
To specify whether to automatically perform color registration adjustment.
Values:

• Adjust ColorRegi
Purpose:
To manually perform color registration adjustment.
Manual Color Registration Adjustments are required when the printer is initially installed and after the 
printer is moved.

NOTE: 
• The Adjust ColorRegi feature can be configured when Auto Adjust Regi is set to Off.

Values:

NOTE: 
• Ensure that you remove the paper from the single sheet feeder (SSF) before performing Auto Adjust.

Labels 0*

-6 to +6
LW Gloss Card 0*

-6 to +6
HW Gloss Card 0*

-6 to +6

Off Does not automatically perform color registration adjustment.
On* Automatically performs color registration adjustment.

Auto Adjust Automatically performs color registration correction. 

ColorRegi Chart Prints a color registration chart. The color registration chart prints a 
lattice pattern of yellow, magenta, and cyan lines. On the chart, find 
the values on the right side that are next to the line that is perfectly 
straight for each of the three colors. If the value for this line is 0, 
color registration adjustment is not required. If the value for this 
line is any value other than 0, specify the adjustment values for 
lateral adjustment and process adjustment under Enter Number.

Enter Number LY -9 to +9 Sets lateral (perpendicular to paper feed direction) and process 
(paper feed direction) color adjustment values individually for 
Yellow, Magenta, and Cyan. Enter a number in order of lateral 
adjustment (left), lateral adjustment (right), and process 
adjustment. Press the  button to save all the settings.

LM
LC
RY -9 to +9
RM
RC
PY -9 to +9
PM
PC
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• Clean Developer
Purpose:
To stir the toner in a new toner cartridge.

• Toner Refresh
Purpose:
To clean the toner in each toner cartridge.
Values:

• Drum Refresh
Purpose:
To clean the surface of the drum cartridge.

• Initialize NVM
Purpose:
To initialize the non-volatile (NV) memory. After executing this function and rebooting the printer, all 
the menu parameters are reset to their default values.

See also: 
• "Resetting to Factory Defaults" on page 177.

• Init Print Meter
Purpose:
To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to 
zero.

• Reset Fuser
Purpose:
To initialize the Machine Control Unit life counter.

Yellow Crtrdg Cleans the toner in the yellow toner cartridge.

Magenta Crtrdg Cleans the toner in the magenta toner cartridge.

Cyan Crtrdg Cleans the toner in the cyan toner cartridge.

Black Crtrdg Cleans the toner in the black toner cartridge.



167 Using the Operator Panel Menus

• Clear Storage
NOTE: 
• Clear Storage feature is available only when the 512 MB optional memory module is installed.

Purpose:
To clear all files stored as Secure Print, Sample Print, and Stored Print in the RAM disk.
Values:

• Non-Genuine
Purpose:
To use toner cartridge of another manufacturer.

NOTE: 
• Using a non-Fuji Xerox toner cartridge may severely damage your printer. The warranty does not cover 

damages caused by using non-Fuji Xerox toner cartridges.

Values:

• Adjust Altitude
Purpose:
To specify the altitude of the location where the printer is installed.
The discharge phenomenon for charging the photo conductor varies with barometric pressure. 
Adjustments are performed by specifying the altitude of the location where the printer is being used.

NOTE: 
• An incorrect altitude adjustment setting leads to problems such as poor printing quality and incorrect 

indication of remaining toner.

Values:

Secure Settings
Use the Secure Settings menu to set a password to limit access to the menus. This prevents 
items from being changed accidentally.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

All Clear Deletes all files stored as Secure Print and Sample Print in the RAM 
disk.

Secure Document Deletes all files stored as Secure Print in the RAM disk.

Stored Document Deletes all files stored as Stored Print in the RAM disk.

Toner Off* Does not use toner cartridge of another manufacturer.

On Uses toner cartridge of another manufacturer.

0m* Sets the altitude of the location where the printer is installed.

1000m
2000m
3000m
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• Panel Lock
Purpose:
To set a limited access to Admin Menu with a password, and to set or change the password. 

See also: 
• "Panel Lock Function" on page 173.

Values:

• Login Error
NOTE: 
• Login Error feature is available only when Panel Lock Set is set to Enable.

Purpose:
To specify the number of error entry attempts allowed when you log in as an administrator in the 
Admin Menu and Report/List menu.
Values:

Panel Lock Set Disable* Disables password protection for Admin Menu.

Enable Enables password protection for Admin Menu.

Change Password*1 0000–9999 Sets or changes the password required to access Admin 
Menu.

*1 This item is available only when Panel Lock Set is set to Enable.

Off* Does not allow an administrator to log in after one error entry attempt.

On 5 times* Sets the number of error entry attempts allowed when an 
administrator logs in.1-10
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Tray Settings
Use the Tray Settings menu to define the print media loaded in the standard 250-sheet tray and 
the optional 250-sheet feeder.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.
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Tray 1
Purpose:
To specify the paper loaded in the standard 250-sheet tray.
Values:

Paper Size
mm series

A4 - 210x297*
A5 - 148x210
B5 - 182x257
Letter - 8.5x11
US Folio-8.5x13
Legal - 8.5x14
Executive
Monarch Env.
Monarch Env. L
DL Env- 110x220
DL Env. L
C5 Env- 162x229
#10Env- 4.1x9.5
New Custom Size Portrait (Y) 297 mm* Specifies the 

length of the 
custom size paper.

127 - 355 mm

Landscape (X) 210 mm* Specifies the width 
of the custom size 
paper.

77 - 215 mm

inch series Letter - 8.5x11*
US Folio-8.5x13
Legal - 8.5x14
A4 - 210x297
A5 - 148x210
B5 - 182x257
Executive
Monarch Env.
Monarch Env. L
DL Env- 110x220
DL Env. L
C5 Env- 162x229
#10Env- 4.1x9.5
New Custom Size Portrait (Y) 11.7 inch* Specifies the 

length of the 
custom size paper.

5.0-14.0 inches

Landscape (X) 8.3 inch* Specifies the width 
of the custom size 
paper.

3.0-8.5 inches
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NOTE: 
• For more information on supported paper sizes, see also "Usable Print Media" on page 100.

Paper Type Plain*

Light Card
Heavy Card
Envelope
Labels
Letterhead
LW Gloss Card
HW Gloss Card
Hole Punched
Colored
Special

Display Screen Off Does not display a popup menu that prompts to set Paper 
Type and Paper Size when paper is loaded in the standard 
250-sheet tray.

On* Displays a popup menu that prompts to set Paper Type and 
Paper Size when paper is loaded in the standard 250-sheet 
tray.

*1 The default for Paper Size varies depending on country-specific factory default.
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Tray 2
NOTE: 
• Tray 2 feature is available only when the optional 250-sheet feeder is installed.

Purpose:
To specify the paper loaded in the optional 250-sheet feeder. 
Values:

NOTE: 
• For more information on supported paper sizes, see also "Usable Print Media" on page 100.

Paper Size
mm series

A4 - 210x297*1

A5 - 148x210
B5 - 182x257
Letter - 8.5x11
US Folio - 8.5x13
Legal - 8.5x14
Executive

inch series Letter - 8.5x11*1

US Folio - 8.5x13
Legal - 8.5x14
A4 - 210x297
A5 - 148x210
B5 - 182x257
Executive

Paper Type Plain*
Letterhead
Hole Punched
Colored

Display Screen Off Does not display a popup menu that prompts to set Paper 
Type and Paper Size when paper is loaded in the optional 
250-sheet feeder.

On* Displays a popup menu that prompts to set Paper Type and 
Paper Size when paper is loaded in the optional 250-sheet 
feeder.

*1 The default for Paper Size varies depending on country-specific factory default.
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Panel Lock Function
This feature prevents unauthorized users from changing settings made by the administrator. However, 
you can select settings for individual print jobs using the print driver.
This section includes:

• "Enabling the Panel Lock" on page 174
• "Disabling the Panel Lock" on page 175
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Enabling the Panel Lock
1 Press the Menu button.

2 Select Admin Menu, and then press the  button.

3 Select Secure Settings, and then press the  button.

4 Select Panel Lock, and then press the  button.

5 Select Panel Lock Set, and then press the  button.

6 Select Enable, and then press the  button.

7 Enter the new password, and then press the  button.

8 Re-enter the password to confirm the password that you entered, and then press the  button.

NOTE: 
• The factory-default panel password is 0000.
• If you forget your password, turn off the printer. Then, while holding the Menu button, turn on the printer. 

Continue to hold the Menu button until the display indicates to enter the new password. Enter the new 
password, and then press the  button. Re-enter the password, and then press the  button. The display 
will briefly indicate the password has been initialized.

• If you change the password, perform steps 1 to 2. Enter the current password, and then press the  button. 
Perform steps 3 to 4. Select Change Password, and then press the  button. Enter the current password, 
and then press the  button. Perform steps 7 and 8. This will change the password.
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Disabling the Panel Lock
1 Press the Menu button.

2 Select Admin Menu, and then press the  button.

3 Enter the password, and then press the  button.

4 Select Secure Settings, and then press the  button.

5 Select Panel Lock, and then press the  button.

6 Select Panel Lock Set, and then press the  button.

7 Select Disable, and then press the  button.

8 Enter the current password, and then press the  button.
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Setting the Power Saver Time Option
You can set the power saver time for the printer. The printer switches to the Power Saver mode after 
the specified time.

1 Press the Menu button.

2 Select Admin Menu, and then press the  button.

3 Select System Settings, and then press the  button.

4 Select Power Saver Time, and then press the  button.

5 Select Low Power Timer or Sleep Timer, and then press the  button.

6 Press the  or  button or enter the desired value, and then press the  button.
You can select from 3–60 minutes for Low Power Timer or 1–6 minutes for Sleep Timer.

7 To return to the previous screen, press the  (Back) button.
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Resetting to Factory Defaults
After executing Initialize NVM and rebooting the printer, all the menu parameters or data are reset to 
their default values.

1 Press the Menu button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Initialize NVM, and then press the  button.

5 Ensure that Are You Sure? appears, and then press the  button.
The printer restarts automatically to apply the settings.
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7
Troubleshooting

This chapter includes:
• "Clearing Jams" on page 180
• "Basic Printer Problems" on page 199
• "Display Problems" on page 200
• "Printing Problems" on page 201
• "Print Quality Problems" on page 203
• "Adjusting Color Registration" on page 227
• "Other Problems" on page 234
• "Understanding Printer Messages" on page 235
• "Contacting Service" on page 238
• "Getting Help" on page 239
• "Non-Genuine Mode" on page 243
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Clearing Jams
This section includes:

• "Avoiding Jams" on page 181
• "Identifying the Location of Paper Jams" on page 182
• "Clearing Paper Jams From the SSF" on page 183
• "Clearing Paper Jams From the Standard 250-Sheet Tray" on page 186
• "Clearing Paper Jams From the Fuser Unit" on page 189
• "Clearing Paper Jams From the Duplexer" on page 191
• "Clearing Paper Jams From the Optional 250-Sheet Feeder" on page 192

Careful selection of appropriate print media and proper loading allow you to avoid most jams. 

See also: 
• "About Print Media" on page 94
• "Supported Print Media" on page 98

NOTE: 
• Before buying large quantities of any print media, it is recommended that you try a sample first.
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Avoiding Jams
• Use only recommended print media.
• See "Loading Print Media in the Standard 250-Sheet Tray and the Optional 250-Sheet Feeder" 

on page 105 and "Loading Print Media in the Single Sheet Feeder (SSF)" on page 110 to load 
print media properly.

• Do not overload the print media sources. Ensure that the print media stack height does not 
exceed the maximum height indicated by the load-line labels in the tray.

• Do not load wrinkled, creased, damp, or curled print media.
• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try 

feeding one sheet at a time through the single sheet feeder (SSF).
• Do not use print media that you have cut or trimmed.
• Do not mix print media sizes, weights, or types in the same print media source.
• Ensure that the recommended print side is face up when you load the print media in the standard 

250-sheet tray and the optional 250-sheet feeder. Also, the recommended print side should be 
face down when you use the SSF.

• Keep print media stored in an acceptable environment.
• Do not remove the feeding tray during a print job.
• Push the tray in firmly after loading.
• Ensure that all cables that connect to the printer are correctly attached.
• Overtightening the guides may cause jams.
• Wipe the feed roller in the tray or SSF with a cloth that is slightly dampened with water if jams 

caused by misfeeding paper occur frequently.

See also: 
• "About Print Media" on page 94 
• "Supported Print Media" on page 98
• "Print Media Storage Guidelines" on page 97
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Identifying the Location of Paper Jams

IMPORTANT: 
• Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

CAUTION:
• Do not attempt to remove a paper jammed deeply inside the product, particularly a paper wrapped 

around a Fuser Unit or a heat roller. Otherwise, it may cause injuries or burns. Switch off the product 
promptly and contact your local Fuji Xerox representative.

1 Fuser Unit

2 Duplexer

3 Optional 250-Sheet Feeder

4 Standard 250-Sheet Tray

5 Single Sheet Feeder (SSF)

6 Front Cover

1

35

2

4

6
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Clearing Paper Jams From the SSF
IMPORTANT: 
• Protect the drums of the drum cartridge against bright light. If the front cover remains open for more than 3 

minutes, print quality may deteriorate.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Pull the jammed paper out of the SSF. If you cannot remove the jammed paper or cannot find any 
jammed paper there, go to the next step to remove the jammed paper from the inside of the 
printer.

2 Remove the standard 250-sheet tray from the printer, and then pull out the jammed paper 
remaining inside the printer. If you cannot remove the jammed paper or cannot find any jammed 
paper there, go to the next step to remove the jammed paper from the inside of the printer.

3 Push the side button to open the front cover.
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4 Open the belt unit until it stops and remove the jammed paper. Confirm that there are no scraps 
of paper remaining inside the printer.

5 Close the belt unit, and push at the top of the unit until it clicks.

6 Close the front cover.
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7 Insert the standard 250-sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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Clearing Paper Jams From the Standard 250-Sheet Tray
IMPORTANT: 
• Protect the drums of the drum cartridge against bright light. If the front cover remains open for more than 3 

minutes, print quality may deteriorate.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Pull the standard 250-sheet tray out of the printer carefully. Hold the tray with both hands, lift the 
front slightly, and remove it from the printer.

2 Remove all the jammed and/or creased paper from the tray.

3 Pull the jammed paper out carefully to avoid tearing it. If you cannot remove the paper, go to the 
next step to remove the jammed paper from the inside of the printer.

4 Push the side button to open the front cover.
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5 Open the belt unit until it stops and remove the jammed paper. Confirm that there are no scraps 
of paper remaining inside the printer.

6 Close the belt unit, and push at the top of the unit until it clicks.

7 Close the front cover.
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8 Insert the standard 250-sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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Clearing Paper Jams From the Fuser Unit
IMPORTANT: 
• Ensure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from 

your hands on the film of the belt unit may reduce print quality.
• Protect the drums of the drum cartridge against bright light. If the front cover remains open for more than 3 

minutes, print quality may deteriorate.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Turn off the printer and wait for 30 minutes.

2 Push the side button to open the front cover.

3 Open the belt unit.

4 Lift the levers at both ends of the fuser unit, and remove the jammed paper. If you are still unable 
to remove the paper, go to the next step.

CAUTION:
• The fuser unit is hot. Do not touch it, doing so may cause burns.
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5 Open the cover of the fuser unit and remove the jammed paper.

6 Close the cover of the fuser unit and press down the levers at both ends of the fuser unit.

7 Confirm that there are no scraps of paper remaining inside the printer, and then close the belt 
unit.

8 Close the front cover.
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Clearing Paper Jams From the Duplexer 
NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Push the side button to open the front cover.

2 Open the cover of the duplexer.

3 Remove the jammed paper from the duplexer.

4 Close the cover of the duplexer.

5 Close the front cover.
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Clearing Paper Jams From the Optional 250-Sheet 
Feeder

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Pull the optional 250-sheet feeder out of the printer carefully. Hold the feeder with both hands, 
and remove it from the printer.

NOTE: 
• Paper in the optional 250-sheet feeder feeds to the printer from the front of the standard 250-sheet tray, 

therefore paper jammed in the standard 250-sheet tray can block the optional 250-sheet feeder in the 
printer, preventing you from opening it. Look for the jammed paper sequentially, starting with the optional 
250-sheet feeder.

2 Remove all jammed and/or creased paper from the feeder.

3 Pull the jammed paper out carefully to avoid tearing it. If you cannot remove the paper, go to the 
next step to remove the jammed paper from the inside of the printer.

4 Push the side button to open the front cover.
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5 Open the belt unit until it stops and remove the jammed paper. Confirm that there are no scraps 
of paper remaining inside the printer.

6 Close the belt unit, and push at the top of the unit until it clicks.

7 Close the front cover.
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NOTE: 
• If the paper jam message is not cleared after you close the front cover, pull out the standard 250-sheet 

tray and check if there is a jammed paper in the opening of the tray.

8 Insert the optional 250-sheet feeder into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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Jam Problems
This section includes:

• "Standard 250-Sheet Tray Misfeed Jam" on page 195
• "SSF Misfeed Jam" on page 196
• "Optional 250-Sheet Feeder Misfeed Jam" on page 197
• "Regi Jam (Exit Sensor On JAM)" on page 197
• "Exit Jam (Exit Sensor Off JAM)" on page 198
• "Standard 250-Sheet Tray/Optional 250-Sheet Feeder Multi-feed Jam" on page 198
• "SSF Multi-feed Jam" on page 198

Standard 250-Sheet Tray Misfeed Jam

Problem Action
Print media misfeeds occur in the 
standard 250-sheet tray.

Ensure that the standard 250-sheet tray is properly inserted.

If the problem persists, verify that the correct print media is being 
used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 100

If not, use the print media recommended for the printer.

If the problem persists, ensure that the print media is not damp.

Ensure that the print media is not curled.

If the problem persists, fan the print media.

Ensure that the print media is not damp.

If the print media is damp, turn over the print media.

If the problem persists, use print media that is not damp.

If the print media is not damp, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the standard 250-sheet 
tray with a cloth moistened with water.

Wipe the feed roller in the standard 250-sheet tray with a cloth 
moistened with water.

If the problem persists, replace the drum cartridge if you have a spare 
cartridge. 

Replace the drum cartridge if you have a spare cartridge.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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SSF Misfeed Jam

Problem Action
Print media misfeeds occur in the 
SSF.

Ensure that the SSF is properly inserted.

If the problem persists, verify that the correct print media is being 
used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 100

If not, use the print media recommended for the printer.

If the problem persists, ensure that the print media is not damp.

Ensure that the print media is not curled.

If the problem persists, fan the print media.

Ensure that the print media is not damp.

If the print media is damp, turn over the print media.

If the problem persists, use print media that is not damp.

If the print media is not damp, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the SSF with a cloth 
moistened with water.

Wipe the feed roller in the SSF with a cloth moistened with water.

If the problem persists, replace the drum cartridge if you have a spare 
cartridge. 

Replace the drum cartridge if you have a spare cartridge.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Optional 250-Sheet Feeder Misfeed Jam

Regi Jam (Exit Sensor On JAM)

Problem Action
Print media misfeeds occur in the 
optional 250-sheet feeder.

Ensure that the optional 250-sheet feeder is properly inserted.

If the problem persists, ensure that the side cover is closed.

Ensure that the side cover is closed.

If the problem persists, verify that the correct print media is being 
used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 100

If not, use the print media recommended for the printer.

If the problem persists, ensure that the print media is not damp.

Ensure that the print media is not curled.

If the problem persists, fan the print media.

Ensure that the print media is not damp.

If the print media is damp, turn over the print media.

If the problem persists, use print media that is not damp.

If the print media is not damp, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the optional 250-sheet 
feeder with a cloth moistened with water.

Wipe the feed roller in the optional 250-sheet feeder with a cloth 
moistened with water.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.

Problem Action
Regi jam (Exit Sensor On JAM) 
occurs.

Ensure that the drum cartridge is installed correctly.

If the problem persists, replace the drum cartridge if you have a spare 
cartridge as instructed in "Replacing the Drum Cartridge" on 
page 257.

Replace the drum cartridge if you have a spare cartridge as instructed 
in "Replacing the Drum Cartridge" on page 257.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Exit Jam (Exit Sensor Off JAM)

Standard 250-Sheet Tray/Optional 250-Sheet Feeder Multi-feed Jam

SSF Multi-feed Jam

Problem Action
Exit jam (Exit Sensor Off JAM) 
occurs.

Ensure that the fuser unit is installed correctly.

Replace the fuser unit.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.

Problem Action
Print media multiple feeds occur 
in the standard 250-sheet tray or 
optional 250-sheet feeder.

Ensure that the tray is properly inserted.

If using coated paper, load coated paper one sheet at a time.

If using other type of print media, use print media that is not dump.

Load coated paper one sheet at a time.

If the problem persists, fan the print media.

Use print media that is not dump.

If the problem persists, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the tray where the 
multifeed occurred with a cloth moistened with water.

Wipe the feed roller in the tray where the multifeed occurred with a 
cloth moistened with water.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.

Problem Action
Print media multiple feeds occur 
in the SSF.

Ensure that the media type you are using.

If using coated paper, load coated paper one sheet at a time.

If using other type of print media, use print media that is not dump.

Load coated paper one sheet at a time.

If the problem persists, fan the print media.

Use print media that is not dump.

If the problem persists, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the tray where the 
multifeed occurred with a cloth moistened with water.

Wipe the feed roller in the tray where the multifeed occurred with a 
cloth moistened with water.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Basic Printer Problems
Some printer problems can be easily resolved. If a problem occurs with your printer, check each of the 
following:

• The power cord is connected to the printer, and to a properly grounded electrical outlet.
• The printer is turned on.
• The electrical outlet is not turned off at any switch or breaker.
• Other electrical equipment plugged into the outlet is working.
• The optional memory module is properly installed.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, 
and then turn on the printer. This often fixes the problem.
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Display Problems

Problem Action
After the printer is turned on, the 
display on the LCD panel is 
blank, keeps showing Please 
wait..., or the back light is not lit.

Turn off the printer, wait for 10 seconds, and turn on the printer. Self 
Test Message appears on the LCD panel. When the test is 
completed, Ready is displayed.

Menu settings changed from the 
operator panel have no effect.

Settings in the software program, the print driver, or the printer utilities 
have precedence over the settings made on the operator panel.
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Printing Problems

Problem Action
Job did not print or incorrect 
characters printed.

Ensure that the top menu appears on the LCD panel before you send 
a job to print. Press the Menu button to return to the top menu.

Ensure that the print media is loaded in the printer. Press the Menu 
button to return to the top menu.

Verify that you are using the correct print driver.

Ensure that the correct USB or Ethernet cable is securely connected 
to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Check the printer's interface from the Admin Menu.

Determine the host interface you are using. Print a panel settings 
page to verify that the current interface settings are correct.

Print media misfeeds or multiple 
feeds occur in the standard 
250-sheet tray or SSF.

Ensure that the print media you are using meets the specifications for 
your printer.

See also: 
• "Usable Print Media" on page 100

Fan the print media before loading it in the standard 250-sheet tray.

Ensure that the print media is loaded correctly.

Ensure that the width and length guides of the print media sources 
are adjusted correctly.

Ensure that the standard 250-sheet tray is securely inserted.

Do not overload the tray.

Do not force print media into the SSF when you load it; otherwise, it 
may skew or buckle.

Ensure that the print media is not curled.

Face the recommended print side up or down appropriately for the 
type of print media you are using.

See also: 
• "Loading Print Media" on page 103

Turn the print media over or around and try printing again to see if 
feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading 
the print media.

Load print media only when the tray is empty.

Wipe the feed roller in the standard 250-sheet tray or SSF with a cloth 
moistened with water.

Replace the feed roller.

The envelope is creased after 
printed.

Make sure that the envelope is loaded in the standard 250-sheet tray 
or SSF as instructed in "Loading Envelope in the Standard 250-Sheet 
Tray" on page 107 or "Loading Envelope in the Single Sheet Feeder 
(SSF)" on page 111.
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Page breaks in unexpected 
places.

Increase the value for the time-out on the operator panel or 
CentreWare Internet Services. 

Print media does not stack neatly 
in the output bin.

Turn the print media stack over in the tray.

Cannot print from the standard 
250-sheet tray because the print 
media in the tray is curled.

Load the print media into the SSF.

Problem Action
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Print Quality Problems
This section includes:

• "The Output Is Too Light" on page 204
• "Toner Smears or Print Comes Off" on page 206
• "Random Spots/Blurred Images" on page 207
• "The Entire Output Is Blank" on page 208
• "Streaks Appear on the Output" on page 210
• "Part or the Entire Output Is Black" on page 211
• "Pitched Color Dots" on page 212
• "Vertical Blanks" on page 213
• "Ghosting" on page 215
• "Light-Induced Fatigue" on page 216
• "Fog" on page 217
• "Bead-Carry-Out (BCO)" on page 218
• "Jagged Characters" on page 219
• "Banding" on page 220
• "Auger Mark" on page 221
• "Wrinkled/Stained Paper" on page 222
• "Damage on the Leading Edge of Paper" on page 223

NOTE: 
• In this section, some procedures use the operator panel or CentreWare Internet Services.

See also: 
• "Understanding the Printer Menus" on page 142
• "CentreWare Internet Services" on page 53
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The Output Is Too Light
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Problem Action
The output is too light. The toner cartridges may be low or need to be replaced. Confirm the 

amount of toner in each toner cartridge.
1 Check the toner level in the Printer Status window.
2 Replace the toner cartridges as necessary.

If the problem persists, disable Draft Mode in the print driver.

Disable Draft Mode in the print driver. The following procedure uses 
the PCL 6 driver as an example.
1 On the Advanced Settings tab, ensure that the Draft Mode check 

box is not selected.

If the problem persists, try changing the Paper Type setting in the 
print driver.

The print media surface may be uneven. Try changing the Paper 
Type setting in the print driver. For example, change the plain paper 
to heavy using a PCL 6 driver.
1 On the Paper / Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being 
used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 100

If not, use the print media recommended for the printer.

If the problem persists, ensure that the eight yellow ribbons are 
correctly removed from the drum cartridge.

Ensure that the eight yellow ribbons are correctly removed from the 
drum cartridge.

See also: 
• "Installing a Toner Cartridge" on page 255
• "Installing the Drum Cartridge" on page 260

If not, remove the ribbons.

If the problem persists, replace the drum cartridge if you have a spare 
cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Toner Smears or Print Comes Off

Problem Action
Toner smears or print comes off. The print media surface may be uneven. Try changing the Paper 

Type setting in the print driver. For example, change the plain paper 
to heavy using a PCL 6 driver.
1 On the Paper / Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being 
used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 100

If not, use the print media recommended for the printer.

If the problem persists, replace the drum cartridge if you have a spare 
cartridge.

Replace the drum cartridge if you have a spare cartridge.
1 Replace the drum cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260
2 After you replace the drum cartridge, test print your document 

again.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Random Spots/Blurred Images

Problem Action
The printed result has random 
spots or is blurred.

Ensure that the toner cartridges are installed correctly. 

See also: 
• "Installing a Toner Cartridge" on page 255

If the problem persists, ensure that the drum cartridge is installed 
correctly.

Ensure that the drum cartridge is installed correctly.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, replace the drum cartridge if you have a spare 
cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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The Entire Output Is Blank



209 Troubleshooting

Problem Action
The entire output is blank. The toner cartridges may be low or need to be replaced. Confirm the 

amount of toner in each toner cartridge.
1 Check the toner level in the Printer Status window.
2 Replace the toner cartridges as necessary.

If the problem persists, disable Draft Mode in the print driver.

Disable Draft Mode in the print driver. The following procedure uses 
the PCL 6 driver as an example.
1 On the Advanced Settings tab, ensure that the Draft Mode check 

box is not selected.

If the problem persists, try changing the Paper Type setting in the 
print driver.

The print media surface may be uneven. Try changing the Paper 
Type setting in the print driver. For example, change the plain paper 
to heavy using the PCL 6 driver.
1 On the Paper / Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being 
used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 100

If not, use the print media recommended for the printer.

If the problem persists, ensure that the eight yellow ribbons are 
correctly removed from the drum cartridge.

Ensure that the eight yellow ribbons are correctly removed from the 
drum cartridge.

See also: 
• "Installing a Toner Cartridge" on page 255
• "Installing the Drum Cartridge" on page 260

If not, remove the ribbons.

If the problem persists, replace the drum cartridge if you have a spare 
cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Streaks Appear on the Output

Problem Action
Streaks appear on the output. The toner cartridges may be low or need to be replaced. Confirm the 

amount of toner in each toner cartridge.
1 Check the toner level in the Printer Status window.
2 Replace the toner cartridges as necessary.

If the problem persists, replace the drum cartridge if you have a spare 
cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Part or the Entire Output Is Black

Problem Action
Part or the entire output is black. Ensure Output Color is set to Color in the print driver. The following 

procedure uses the PCL 6 driver as an example.
1 On the Image Options tab, ensure that the Output Color is set to 

Color.
If the problem persists, replace the drum cartridge if you have a spare 
cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Pitched Color Dots

Problem Action
The printed result has pitched 
color dots.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.



213 Troubleshooting

Vertical Blanks

Problem Action
The printed result has vertical 
blanks.

Ensure the light path is not covered.
1 Remove the drum cartridge, and keep it in the dark place.

See also: 
• "Replacing the Drum Cartridge" on page 257
2 Check the light path, and then remove the shielding.
3 Re-install the drum cartridge.

See also: 
• "Installing the Drum Cartridge" on page 260

If the problem persists, replace the drum cartridge if you have a spare 
cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Mottle

Problem Action
The printed result has mottled 
appearance.

Verify that the print media recommended for the printer is being used.

If you use non-recommended print media, use the print media 
recommended for the printer.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Ghosting

Problem Action
The printed result has ghosting. If the type of the ghosting is positive ghost:

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.

If the type of the ghosting is negative ghost:

Verify that the print media recommended for the printer is being used.

If you are using non-recommended print media, use the print media 
recommended for the printer.

If the problem is solved, adjust the transfer bias.

If the problem persists, replace the drum cartridge if you have a spare 
cartridge.

Adjust the transfer bias.
1 On the operator panel, press the Menu button and select Admin 
Menu → Maintenance Mode → Adjust BTR.

2 Adjust the setting for the type of print media being used.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Light-Induced Fatigue

Problem Action
The printed result has 
light-induced fatigue pattern.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Fog

Problem Action
The printed result is foggy. Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Bead-Carry-Out (BCO)

Problem Action
Bead-Carry-Out (BCO) is 
happening.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Jagged Characters

Problem Action
The printed result has jagged 
characters.

Set Screen to Fineness in the print driver. The following procedure 
uses the PCL 6 driver as an example.
1 On the Advanced Settings tab, set Screen under Items: to 

Fineness.

If the problem persists, set Image Quality to High Quality in the print 
driver.

Set Image Quality to High Quality in the print driver. The following 
procedure uses the PCL 6 driver as an example.
1 On the Image Options tab, select High Quality from Image 

Quality.

If the problem persists, enable Bitmap Smoothing in the print driver.

Enable Bitmap Smoothing in the print driver. The following 
procedure uses the PCL 6 driver as an example.
1 On the Advanced Settings tab, set Bitmap Smoothing under 

Items: to On.

If the problem persists, enable Bitmap Text Smoothing in the print 
driver.

Enable Bitmap Text Smoothing in the print driver. The following 
procedure uses the PCL 6 driver as an example.
1 On the Advanced Settings tab, set Bitmap Text Smoothing 

under Items: to On.

If the problem persists, check whether or not the downloaded font you 
are using is recommended.

If using a downloaded font, ensure that the font is recommended for 
the printer, operating system, and the application being used.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Banding

Problem Action
The printed result has banding. Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Auger Mark

Problem Action
The printed result has auger 
mark.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Wrinkled/Stained Paper

Problem Action
The output is wrinkled.
The output is stained.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 100
• "About Print Media" on page 94

If not, use the print media recommended for the printer.

If the problem with printing on an envelope persists, check the wrinkle 
of the envelope.

If the problem with printing on a print media other than envelopes 
persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Check whether the wrinkle of the four edges of the envelope is within 
30 mm.

If the wrinkle of the four edges of the envelope is within 30 mm, this 
type of wrinkle is considered normal. Your printer is not at fault.

If not, take following actions:
• If the envelope is 220 mm or longer (C5 or Com-10), load the 

envelope in the standard 250-sheet tray in the short edge feed 
orientation with the flap closed and print side up.

• If the envelope is shorter than 220 mm (Monarch or DL), load the 
envelope in the standard 250-sheet tray in the short edge feed 
orientation with the flap closed and print side up, or in the long 
edge feed orientation with the flap open and print side up.

Load the envelopes in the standard 250-sheet tray in the short edge 
feed orientation with the flap closed and print side up.

See also: 
• "Loading Envelope in the Standard 250-Sheet Tray" on page 107

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.

Load the envelopes in the standard 250-sheet tray in the long edge 
feed orientation with the flap open and print side up.

See also: 
• "Monarch or DL" on page 108

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Damage on the Leading Edge of Paper

Problem Action
The output is damaged on its 
leading edge.

When using the SSF, reverse the paper and then try again. 

If the problem persists, change the paper with another one and then 
try again.

When using the standard 250-sheet tray or optional 250-sheet feeder, 
change the paper and then try again.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.

Change the paper with another one and then try again.

If the problem persists, use the standard 250-sheet tray or optional 
250-sheet feeder in place of the SSF.

Use the standard 250-sheet tray or optional 250-sheet feeder in place 
of the SSF.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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The Top and Side Margins Are Incorrect

Problem Action
The top and side margins are 
incorrect.

Ensure that the margins are set correctly on the application being 
used.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Color Registration Is out of Alignment

Problem Action
Color registration is out of 
alignment.

Execute auto color registration adjustment.
1 On the operator panel, press the Menu button and select Admin 
Menu → Maintenance Mode → Adjust ColorRegi → Auto 
Adjust, and then press the  button.

If the problem persists, check whether or not you have a spare drum 
cartridge.

Check whether or not you have a spare drum cartridge.

If you have a spare drum cartridge, replace the drum cartridge.

If you do not have a spare drum cartridge, contact the Fuji Xerox local 
representative office or an authorised dealer.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257
• "Installing the Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Protrudent/Bumpy Paper

Problem Action
Printed surface got 
protrudent/bumpy.

Clean up the fuser unit.
1 Load one sheet of paper on the SSF, and then print a solid image 

all over paper.
2 Load the printed sheet with the side to be printed on facing down, 

and then print a blank sheet of paper.

If the problem persists, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Adjusting Color Registration
This section describes how to adjust the color registration when you first install the printer or after 
moving it to a new location.
This section includes:

• "Performing Auto Adjust" on page 228
• "Printing the Color Registration Chart" on page 229
• "Determining Values" on page 230
• "Entering Values" on page 231
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Performing Auto Adjust
Auto Adjust allows you to correct the color registration automatically.

The Operator Panel

1 Press the Menu button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Adjust ColorRegi, and then press the  button.

5 Select Auto Adjust, and then press the  button.

6 Ensure that Are You Sure? appears, and then press the  button.
Auto adjust is performed.
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Printing the Color Registration Chart 
1 Press the Menu button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Adjust ColorRegi, and then press the  button.

5 Select ColorRegi Chart, and then press the  button.

6 Ensure that Are You Sure? appears, and then press the  button.
The color registration chart is printed.
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Determining Values
On the color registration chart, there are two types of charts: Chart 1 (fast scan) and Chart 2 (slow 
scan).
The Chart 1 is used to adjust the color registration for the fast scan direction, which is vertical to paper 
feed direction. The Chart 2 is used to adjust the color registration for the slow scan direction, which is 
horizontal to paper feed direction.
The following sections explain how to determine the adjustment values for the fast scan and the slow 
scan using Chart 1 and Chart 2.

Fast Scan
On the Chart 1 of the color registration chart, find the straightest lines where the two black lines and 
the colored line are most closely aligned for each color (Y, M, and C). If you find the straightest line, 
make a note of the value (-9 to +9) indicated by the straightest line for each color.
When the value is 0 for each color, you do not need to adjust the color registration for the fast scan.
When the value is not 0, enter the value using the procedure in "Entering Values" on page 231.

Slow Scan
On the Chart 2 of the color registration chart, find the medium line within the range of white area for 
each color pattern (Y, M, and C). If you find the medium line, make a note of the value (-9 to +9) 
indicated by the medium line for each color.
When the value is 0 for each color, you do not need to adjust the color registration for the slow scan.
When the value is not 0, enter the value using the procedure in "Entering Values" on page 231.

Straightest line
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Entering Values

Using the operator panel, enter the values found in the color registration chart to make adjustments. 

1 Press the Menu button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Adjust ColorRegi, and then press the  button.

5 Select Enter Number, and then press the  button.

6 Ensure that Enter (LY, LM, LC) appears.

7 Press the  or  button to specify the values for LY, LM, and LC.

NOTE: 
• To move the cursor to the next value, press the  button.

8 Press the  button.

9 Ensure that Enter (RY, RM, RC) appears.

10 Press the  or  button to specify the values for RY, RM, and RC.

NOTE: 
• To move the cursor to the next value, press the  button.

11 Press the  button.

12 Ensure that Enter (PY, PM, PC) appears.

13 Press the  or  button to specify the values for PY, PM, and PC.

NOTE: 
• To move the cursor to the next value, press the  button.

Lattice pattern
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14 Press the  button.

15 Select ColorRegi Chart, and then press the  button.

16 Ensure that Are You Sure? appears, and then press the  button.
The color registration chart is printed with the new values.

If the straightest line is not at the value of 0, adjust the values again. Checking the charts before 
and after the adjustments will help you to determine the values to enter.

After printing the color registration chart, do not turn off the printer until the printer motor has stopped 
running.

NOTE: 
• If 0 is not next to the straightest lines, determine the values and adjust the printer again. 
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Problems With Installed Optional Accessories

Problem Action
The optional 250-sheet feeder 
does not work correctly.

Ensure that the optional 250-sheet feeder is correctly installed on the 
printer. Re-install the optional 250-sheet feeder. 

See also: 
• "Removing the Optional 250-Sheet Feeder" on page 288
• "Installing the Optional 250-Sheet Feeder" on page 42

If the problem persists, contact customer support.

Ensure that the print media is loaded correctly.

See also: 
• "Loading Print Media in the Standard 250-Sheet Tray and the 

Optional 250-Sheet Feeder" on page 105

If the problem persists, contact customer support.

The optional memory module 
does not work correctly.

Ensure that the optional memory module is securely connected to the 
memory connector.

If the problem persists, contact customer support.
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Other Problems

Problem Action
Condensation has occurred 
inside the printer.

This usually occurs within several hours after you heat the room in 
winter. This also occurs when the printer is operating in a location 
where relative humidity reaches 85% or more. Adjust the humidity or 
relocate the printer to an appropriate environment.

"092-310", "092-910", or 
"092-410" is displayed. 

Clean the CTD sensor.

See also: 
• "Cleaning the Color Toner Density (CTD) Sensor" on page 250

No Documents is displayed on 
the LCD panel when you are 
selecting a file for Print from USB 
Memory feature.

Confirm that there are files with the supported file formats (PDF, TIFF, 
or JPEG) in the USB storage device.

If the target file is in a deep hierarchy in the USB storage device, 
move the file to the root directory on your computer.

Shorten the target file name in the USB storage device on your 
computer, and try printing again.
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Understanding Printer Messages
The printer LCD panel displays messages describing the current state of the printer and indicates 
possible printer problems you must resolve. This section describes messages, their meanings, and 
how to clear the messages.

IMPORTANT: 
• When an error code is displayed, the print data remaining on the printer and the information accumulated in 

the memory of the printer are not secured.

Error-Code What You Can Do
010-317 Turn off the printer and wait for 30 minutes. Open the front cover and make sure that the 

fuser unit is fully installed.

010-397 Turn off the printer. Confirm that the fuser unit is correctly installed, and turn on the 
printer. Contact customer support if this failure is repeated.

016-404 Contact your system administrator.

016-405

016-500 Turn off the printer, and turn it on again. Contact customer support if this failure is 
repeated.016-501

016-502

016-520 Contact your system administrator.

016-521

016-522

016-523

016-524

016-527

016-737 Turn off the printer, and turn it on again. Contact customer support if this failure is 
repeated.016-738

016-741

016-744

016-750 Press the  button, or wait for 30 seconds for the printer to recover. 

016-753

016-755

016-757 The account is not registered. Contact your system administrator.

016-758 The function cannot be used. Contact your system administrator.

016-759 Printable page limit is exceeded. Contact your system administrator. 

016-786 Press the  button, or wait for 30 seconds for the printer to recover. Check if the 
network cable is connected properly. If there is no problem with the network cable, 
contact server administrator.

016-790

016-791 Press the  button, or wait for 30 seconds for the printer to recover.

016-799 Press the  button to clear the message and cancel the current print job. Confirm the 
configuration of the printer on the print driver.

016-930 The device is not supported. Remove it from the USB port.

016-931 The USB hub is not supported. Remove it from the USB port.

024-910 Reload the specified paper on the standard 250-sheet tray. 

024-911 Reload the specified paper on the optional 250-sheet feeder. 
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024-914 Reload the specified paper on the SSF. 

024-923 Open the side cover. Remove the used yellow cartridge, and install a new cartridge.

024-924 Open the side cover. Remove the used magenta cartridge, and install a new cartridge.

024-925 Open the side cover. Remove the used cyan cartridge, and install a new cartridge.

024-946 Insert the standard 250-sheet tray.

024-947 Insert the optional 250-sheet feeder.

027-446 Change IP address to avoid duplication. Turn off the printer, and turn it on again.

027-452

042-700 Wait for a while until the printer cools down.

071-100 Remove the standard 250-sheet tray and jammed paper. Open and close the front 
cover. 

071-920 Set side 2 of the sheet to the standard 250-sheet tray. 

071-921 Press the  button.

072-100 Remove the optional 250-sheet feeder and jammed paper. Open and close the front 
cover. 

072-101 Remove the standard 250-sheet tray or the optional 250-sheet feeder, and remove the 
jammed paper. Open and close the front cover.

072-215 Turn off the printer. Confirm that the optional 250-sheet feeder is correctly installed, and 
turn on the printer. Contact customer support if this failure is repeated.

072-900 Remove the standard 250-sheet tray or the optional 250-sheet feeder, and remove the 
jammed paper. Open and close the front cover. 

072-920 Set side 2 of the sheet to the optional 250-sheet feeder.

072-921 Press the  button.

075-101 Open the front cover and remove the jammed paper, and then open and close the front 
cover.

075-102 Pull the jammed paper out of the SSF. Open and close the front cover.

075-920 Set side 2 of the sheet to the SSF.

075-922 Remove the paper from the SSF.

075-923 Pull the paper out of the SSF. Reload the paper in the SSF.

077-215 Turn off the printer. Confirm that the duplexer is correctly installed, and turn on the 
printer. Contact customer support if this failure is repeated.

077-300 Close the front cover.

077-301 Close the side cover.

091-912 Remove the ribbon from the drum cartridge. Contact customer support if this failure is 
repeated.

091-916 Open the front cover. Remove the unsupported drum cartridge, and install a supported 
cartridge. 

091-941 Open the side cover. Remove the used yellow cartridge, and install a new cartridge.

091-942 Open the side cover. Remove the used magenta cartridge, and install a new cartridge.

091-943 Open the side cover. Remove the used cyan cartridge, and install a new cartridge.

091-944 Open the side cover. Remove the used black cartridge, and install a new cartridge.

091-972 Open the front cover, and make sure that the drum cartridge is fully installed. 

092-410 Clean the CTD sensor.

092-910

093-912 Open the side cover. Remove the used black cartridge, and install a new cartridge.
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093-919 Remove and shake the yellow cartridge. Contact customer support if this failure is 
repeated.

093-920 Remove and shake the magenta cartridge. Contact customer support if this failure is 
repeated.

093-921 Remove and shake the cyan cartridge. Contact customer support if this failure is 
repeated.

093-922 Remove and shake the black cartridge. Contact customer support if this failure is 
repeated.

093-925 Turn off the printer. Confirm the black cartridge is correctly installed, and turn on the 
printer. Contact customer support if this failure is repeated.

093-926 Open the side cover. Remove the unsupported black cartridge, and install a supported 
cartridge.

093-950 Turn off the printer. Confirm the yellow cartridge is correctly installed, and turn on the 
printer. Contact customer support if this failure is repeated.

093-951 Turn off the printer. Confirm the magenta cartridge is correctly installed, and turn on the 
printer. Contact customer support if this failure is repeated.

093-952 Turn off the printer. Confirm the cyan cartridge is correctly installed, and turn on the 
printer. Contact customer support if this failure is repeated.

093-960 Open the side cover. Remove the unsupported yellow cartridge, and install a supported 
cartridge.

093-961 Open the side cover. Remove the unsupported magenta cartridge, and install a 
supported cartridge.

093-962 Open the side cover. Remove the unsupported cyan cartridge, and install a supported 
cartridge.

093-970 Open the side cover, and make sure that the yellow cartridge is fully installed. 

093-971 Open the side cover, and make sure that the magenta cartridge is fully installed.

093-972 Open the side cover, and make sure that the cyan cartridge is fully installed.

093-973 Open the side cover, and make sure that the black cartridge is fully installed.

116-316 Turn off the printer. Remove the 512 MB optional memory module from the slot, and 
then reattach it firmly. Turn on the printer. Contact customer support if this failure is 
repeated.

116-317 Turn off the printer, and turn it on again. Contact customer support if this failure is 
repeated.

116-320 Remove the unsupported additional memory module. Contact customer support if this 
failure is repeated.
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Contacting Service
When you call for printer service, be prepared to describe the problem you are experiencing or the 
error message on the LCD panel.
You need to know the model type and service tag of your printer. See the label located on the rear of 
your printer.
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Getting Help
This section includes:

• "LCD Panel Messages" on page 240
• "SimpleMonitor Alerts" on page 241
• "Obtaining the Product Information" on page 242

Fuji Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.
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LCD Panel Messages
The LCD panel provides you with information and troubleshooting help. When an error or warning 
condition occurs, the LCD panel displays a message informing you of the problem. 

See also: 
• "Understanding Printer Messages" on page 235
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SimpleMonitor Alerts
The SimpleMonitor is a tool that is included on the Driver CD Kit. It automatically checks the printer 
status when you send a print job. If the printer is unable to print your job, the SimpleMonitor 
automatically displays an alert on your computer screen to let you know that the printer needs 
attention.
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Obtaining the Product Information

Obtaining the Latest Print Driver
The latest print driver can be obtained by downloading it from our web site.
The following procedure uses the PCL 6 driver as an example.

NOTE: 
• The communication fee shall be borne by users. 

1 In your print driver's Printing Preferences dialog box, click the Advanced Settings tab and then 
click About.

2 Click Fuji Xerox Web Site.
Your web browser launches and our web site is displayed.

3 Follow the instructions on the web site and download an appropriate print driver.

NOTE: 
• You can browse our web site also on the Driver CD Kit included with the printer. To access the web site, click 

Fuji Xerox Web Site on the startup window of the CD-ROM.
• The URL of the driver download service page is as follows: http://www.fujixeroxprinters.com/
• For the latest information about the print driver features, refer to the online Help provided for the print driver.

Updating the Printer's Firmware
Our web site also provides a tool that allows you to update the printer's firmware (software embedded 
within the printer) from your computer.
The latest firmware and updating tool can be downloaded from the following URL.
Follow the instructions on the web site and download the correct firmware update.
http://www.fujixeroxprinters.com/

NOTE: 
• The communication fee shall be borne by users.

http://www.fujixeroxprinters.com/
http://www.fujixeroxprinters.com/
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Non-Genuine Mode
When toner within a toner cartridge is empty, the Replace XXXX Print Cartridge (XXXX: 
Yellow, Magenta, Cyan, or Black) message appears.
When you want to use the printer in Non-Genuine mode, program the mode and replace the print 
cartridge.

IMPORTANT: 
• If you use the printer in the Non-Genuine mode, the performance of the printer may not be at its optimum. And 

any problems that may arise from the use of the Non-Genuine mode are not covered by our quality guarantee. 
The continuous use of the Non-Genuine mode can also cause the printer to break down, and any repair 
charges for such break down will be incurred by users.

NOTE: 
• Before starting the operation described below, confirm that Ready is displayed on the LCD panel.

1 Press the Menu button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Non-Genuine, and then press the  button.

5 Select Toner, and then press the  button.

6 Select On, and then press the  button.

7 Press the  button twice.
The printer switches to the Non-Genuine mode.
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8
Maintenance

This chapter includes:
• "Cleaning the Printer" on page 246
• "Replacing Toner Cartridges" on page 252
• "Replacing the Drum Cartridge" on page 257
• "Replacing the Fuser Unit" on page 263
• "Replacing the Feed Roller Unit" on page 269
• "Ordering Supplies" on page 272
• "Storing Print Media" on page 276
• "Storing Consumables" on page 277
• "Managing the Printer" on page 278
• "Conserving Supplies" on page 281
• "Checking Page Counts" on page 282
• "Moving the Printer" on page 283
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Cleaning the Printer
This section describes how to clean the printer in order to maintain it in good condition and print clean 
printouts all the time.

This section includes:
• "Cleaning Inside the Printer" on page 247
• "Cleaning the Color Toner Density (CTD) Sensor" on page 250

WARNING:
• When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning 

materials may result in poor performance of the product. Never use aerosol cleaners, or it may catch 
fire and cause explosion.

CAUTION:
• When cleaning this product, always switch off and unplug it. Access to a live machine interior may 

cause electric shock.
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Cleaning Inside the Printer
Clean the feed roller inside the printer if print media does not feed correctly.

1 Turn off the printer and disconnect the power cord.

2 Pull the standard 250-sheet tray out of the printer about 200 mm. Hold the standard 250-sheet 
tray with both hands, and remove it from the printer.

3 Push the side button to open the front cover.

4 Open the belt unit.

5 Turn the four drum cartridge lock levers 90-degrees counterclockwise.
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6 Hold the drum cartridge levers, and then pull out the drum cartridge.

NOTE: 
• Keep the drum cartridge in a dark place. If the front cover remains open for more than 3 minutes, print 

quality may deteriorate.

7 Clean the feed roller inside the printer with a dry cloth.

8 Insert the drum cartridge until the line on the handle aligns with the white line on the printer.

9 Turn the four drum cartridge lock levers 90-degrees clockwise to lock the drum cartridge.
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10 Close the belt unit, and push at the top of the unit until it clicks.

11 Close the front cover.

12 Insert the standard 250-sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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Cleaning the Color Toner Density (CTD) Sensor
Clean the Color Toner Density (CTD) sensor only when an alert for the CTD sensor is shown on the 
Printer Status window or operator panel.

1 Turn off the printer and disconnect the power cord.

2 Pull the standard 250-sheet tray out of the printer about 200 mm. Hold the standard 250-sheet 
tray with both hands, and remove it from the printer.

3 Push the side button to open the front cover.

4 Open the belt unit.

5 Clean the CTD sensor inside the printer with a clean dry cotton swab.
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6 Close the belt unit, and push at the top of the unit until it clicks.

7 Close the front cover.

8 Insert the standard 250-sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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Replacing Toner Cartridges
Fuji Xerox toner cartridges are available only through Fuji Xerox. 
It is recommended that you use Fuji Xerox toner cartridges for your printer. Fuji Xerox does not 
provide warranty coverage for problems caused by using accessories, parts, or components not 
supplied by Fuji Xerox.

IMPORTANT: 
• Do not shake the used toner cartridge to avoid spilling of the toner.
• Be sure to use the starter toner cartridge shipped with the printer until it gets empty, and then replace it with a 

purchased one.
• Replace the toner cartridge with the printer turned on. If you turn off the printer, print data remaining in the 

printer, and information stored on the printer's memory are erased.

This section includes:
• "Overview" on page 253
• "Removing the Toner Cartridges" on page 254
• "Installing a Toner Cartridge" on page 255

WARNING:
• Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills.

It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill a large 
volume of toner, contact your local Fuji Xerox representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 
cause burn injuries or explosion.
If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 
its disposal.

CAUTION:
• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, spit it out, 

rinse mouth with water, drink water and consult a physician immediately.
• When replacing toner cartridges, be careful not to spill the toner. In case of any toner spills, avoid 

contact with clothes, skin, eyes and mouth as well as inhalation.
• If toner spills onto your skin or clothing, wash it off with soap and water. 

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary. 
If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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Overview
The printer has toner cartridges of four colors: black (K), yellow (Y), magenta (M), and cyan (C).
When a toner cartridge reaches its usable life-span, the following messages appear on the LCD panel.

IMPORTANT: 
• When placing a used toner cartridge on the floor or on a table, place a few sheets of paper under the toner 

cartridge to catch any toner that may spill.
• Do not reuse old toner cartridges once you remove them from the printer. Doing so can impair print quality.
• Do not shake or pound the used toner cartridges. The remaining toner may spill.
• We recommend you to use up the toner cartridges within one year after removing them from the packaging.

Message Action
Replace XXXX Toner 
Cartridge Soon

The toner cartridge has become empty. Replace the old toner 
cartridge with a new one.
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Removing the Toner Cartridges
1 Open the side cover.

2 Push the latch(es) backwards to pop open the toner cartridge(s) that you want to replace.

3 Pull the cartridge holder until it clicks, and then pull out the toner cartridge.

IMPORTANT: 
• Always pull the toner cartridge out slowly so you do not spill any toner. 
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Installing a Toner Cartridge
1 Unpack a new toner cartridge of the desired color and shake it five to six times to distribute the 

toner evenly.

NOTE: 
• Ensure that the color of the new toner cartridge matches that on the handle before replacing it.
• Handle the toner cartridge carefully to avoid spilling of the toner.

2 Insert the toner cartridge into the associated cartridge holder, and then slide the latch of the toner 
cartridge.

3 Close the side cover.
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Replacing the Drum Cartridge
This section describes how to replace the drum cartridge.

IMPORTANT: 
• Protect the drums of the drum cartridge against bright light. If the front cover remains open for more than 3 

minutes, print quality may deteriorate.
• Ensure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from 

your hands on the film of the belt unit may reduce print quality.
• Replace the drum cartridge with the printer turned on. If you turn off the printer, print data remaining in the 

printer, and information stored on the printer's memory are erased.

This section includes:
• "Removing the Drum Cartridge" on page 258
• "Installing the Drum Cartridge" on page 260
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Removing the Drum Cartridge
1 Pull the standard 250-sheet tray out of the printer about 200 mm. Hold the standard 250-sheet 

tray with both hands, and remove it from the printer.

2 Push the side button to open the front cover.

3 Open the belt unit.

4 Turn the four drum cartridge lock levers 90-degrees counterclockwise.

5 Hold the drum cartridge levers, and then pull out the drum cartridge.



259 Maintenance



Maintenance 260

Installing the Drum Cartridge
1 Open the drum cartridge packaging.

2 Take out the drum cartridge from the packaging.

3 Completely pull out the eight yellow ribbons from the drum cartridge.

4 Remove the rear protective cover from the drum cartridge.

NOTE: 
• Do not remove the front protective cover at this moment.
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5 Insert the drum cartridge until the line on the handle aligns with the white line on the printer.

6 Turn the four drum cartridge lock levers 90-degrees clockwise to lock the drum cartridge.

7 Remove the front protective cover from the drum cartridge.

IMPORTANT: 
• Ensure that you do not hit the belt unit when removing the front protective cover.

8 Close the belt unit, and push at the top of the unit until it clicks.

9 Close the front cover.
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10 Insert the standard 250-sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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Replacing the Fuser Unit
This section describes how to replace the fuser unit.

IMPORTANT: 
• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 

before performing maintenance.
• Avoid bright light and try to finish the replacement within 3 minutes.

This section includes:
• "Removing the Fuser Unit" on page 264
• "Installing the Fuser Unit" on page 266
• "Resetting the Counter of the Fuser Unit" on page 268

CAUTION:
• Before removing the fuser unit, turn off the printer and wait for 40 minutes until the fuser unit cools 

down.
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Removing the Fuser Unit
1 Turn off the printer and disconnect the power cord.

2 Remove any paper in the output tray.

3 Push the side button to open the front cover.

4 Open the belt unit.

5 Pinch the gray lever on the right side of the fuser unit and lower the lever toward you.
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6 Hold both sides of the fuser unit. Next, slightly raise the right side while holding down the left 
side, and slide out the fuser unit.
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Installing the Fuser Unit
1 Insert the protrusions of the new fuser unit into the two slots of the printer.

NOTE: 
• Hold both sides of the fuser unit with your hands.
• Make sure that the fuser unit is firmly set in the slots and cannot be moved easily.

2 Push the fuser unit forward until the right groove of the snaps into place.

3 Close the belt unit, and push at the top of the unit until it clicks.

4 Close the front cover.
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5 Reconnect the power cord to the power connector and turn on the printer.



Maintenance 268

Resetting the Counter of the Fuser Unit
After replacing the fuser unit, use the operator panel to reset the counter of the fuser unit.

1 Press the Menu button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Reset Fuser, and then press the  button.

5 Ensure that Are You Sure? appears, and then press the  button.
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Replacing the Feed Roller Unit
This section describes how to replace the feed roller unit in the standard 250-sheet tray. Regularly 
replacing the feed roller helps ensure the best quality output.
Fuji Xerox feed rollers are available only through Fuji Xerox. To order by phone, see also "Online 
Services" on page 293.
It is recommended that you use Fuji Xerox feed rollers for your printer. Fuji Xerox does not provide 
warranty coverage for problems caused by using accessories, parts, or components not supplied by 
Fuji Xerox.
This section includes:

• "Removing the Feed Roller Unit in the Standard 250-Sheet Tray" on page 270
• "Installing the Feed Roller Unit in the Standard 250-Sheet Tray" on page 271
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Removing the Feed Roller Unit in the Standard 250-Sheet 
Tray

1 Pull the standard 250-sheet tray out of the printer about 200 mm. Hold the standard 250-sheet 
tray with both hands, and remove it from the printer.

NOTE: 
• Ensure that you remove all the paper from the standard 250-sheet tray before removing the feed roller 

unit.

2 Holding the feed roller tabs with your fingers, pull the feed roller unit out of the groove in the axle.
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Installing the Feed Roller Unit in the Standard 250-Sheet 
Tray

1 Align the new feed roller unit with the groove on the axle.

2 Insert the feed roller unit into the axle until it snaps. The protrusions fit completely into the slots 
and the roller hook reseats into the groove on the axle.

3 Load paper in the standard 250-sheet tray, and then insert the standard 250-sheet tray into the 
printer and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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Ordering Supplies
This section includes:

• "Consumables" on page 273
• "When to Order Supplies" on page 274
• "Recycling Supplies" on page 275

Certain consumables and routine maintenance items need to be ordered occasionally. Each supply 
includes installation instructions on the box.
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Consumables
IMPORTANT: 
• Use of consumables/periodical replacement parts not recommended by Fuji Xerox can impair machine quality 

and performance. Use only consumables/periodical replacement parts recommended by Fuji Xerox.

• The number of printable pages are applicable when A4 plain paper SEF ( ) is used and printing is done 
continuously at a density such that each toner covers 5% of the page. These values are estimates and vary 
depending on conditions such as the content being printed, paper size, paper type, the printer's operating 
environment, initializing process done when you turn on or off the printer, and adjustments to maintain print 
quality.

NOTE: 
• Each toner cartridge includes installation instructions on the box.

Product Name Product Code Printable number of pages
Toner Cartridge K CT201632 Approx. 3000 pages

Toner Cartridge C CT201633 Approx. 3000 pages

Toner Cartridge M CT201634 Approx. 3000 pages

Toner Cartridge Y CT201635 Approx. 3000 pages

Drum Cartridge CT350876 Approx. 20000 pages

Fuser Unit-220V EL300822 Approx. 50000 pages

Fuser Unit-110V EL300823 Approx. 50000 pages

Feed Roller Unit EL300775 Approx. 50000 pages
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When to Order Supplies
The LCD panel displays a warning when the supply nears its replacement time. Verify that you have 
replacements on hand. It is important to order these supplies when the messages first appear to avoid 
interruptions to your printing. The LCD panel displays an error message when the supply must be 
replaced.
To order supplies, contact the Fuji Xerox local representative office or an authorised dealer.

IMPORTANT: 
• This printer is designed to provide the most stable performance and print quality when used with the 

recommended consumables. Not using consumables recommended for this machine degrades the 
performance and printing quality of the printer. You could also incur charges if the machine breaks down. To 
receive customer support and achieve the optimum performance of the printer, be sure to use recommended 
consumables.
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Recycling Supplies
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 

cartridges to make recycle parts, recycle materials or energy recovery.
• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges 

containers. Return them to your local Fuji Xerox representative.
• To recover scarce resources, rechargeable batteries used in the returned machines are recycled 

as materials or reused for energy generation.
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Storing Print Media
To avoid potential paper feeding problems and uneven print quality, there are several things you can 
do:

• To achieve the best possible print quality, store print media in an environment where the 
temperature is approximately 70 °F/21 °C and the relative humidity is 40%.

• Store cartons of print media on a pallet or shelf, rather than directly on the floor.
• If you store individual packages of print media out of the original carton, ensure that they rest on 

a flat surface so the edges do not buckle or curl.
• Do not place anything on top of the print media packages.
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Storing Consumables
Store consumables in their original packaging until you need to use them. Do not store consumables 
in:

• Temperatures greater than 104 °F/40 °C.
• An environment with extreme changes in humidity or temperature.
• Direct sunlight.
• Dusty places.
• A car for a long period of time.
• An environment where corrosive gases are present.
• A humid environment.
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Managing the Printer
This section includes:

• "Checking or Managing the Printer with CentreWare Internet Services" on page 279
• "Checking Printer Status with SimpleMonitor (Windows Only)" on page 280
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Checking or Managing the Printer with CentreWare 
Internet Services

When the printer is installed in a TCP/IP environment, you can use CentreWare Internet Services to 
check the printer status, the remaining volume of consumables, and the paper loaded in this printer. 
You can also use CentreWare Internet Services to configure printer settings.

NOTE: 
• When using the printer as a local printer, you cannot use CentreWare Internet Services. For details about 

checking the status of a local printer, refer to "Checking Printer Status with SimpleMonitor (Windows Only)" on 
page 280.

Starting CentreWare Internet Services
Use the following procedure to start CentreWare Internet Services.

1 Launch your web browser.

2 Enter the IP address in the browser’s Address field, and then press the Enter key.
The CentreWare Internet Services screen appears.

• Using Online Help
For details regarding the items that can be set in each CentreWare Internet Services screen, click the 
Help button to display the online Help.
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Checking Printer Status with SimpleMonitor (Windows 
Only)

SimpleMonitor is a tool that is installed with your Fuji Xerox print driver. It automatically checks the 
printer status when you send a print job. SimpleMonitor can check the paper size loaded into the tray, 
the status of the output tray, and the remaining amount of consumables, such as toner cartridges.

Starting SimpleMonitor
Double-click the SimpleMonitor icon on the taskbar or right-click the icon and select Select Printer.
If the SimpleMonitor icon is not displayed on the taskbar, open SimpleMonitor from the Start menu:
The following procedure uses Microsoft® Windows® XP as an example.

1 Click start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate 
SimpleMonitor.
The Select Printer window appears.

2 Click the name of the desired printer from the list.

3 The Printer Status window appears.
For details about the functions of SimpleMonitor, refer to the online Help.
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Conserving Supplies
You can change several settings in your print driver to conserve toner cartridge and paper.
The following descriptions use the PCL 6 driver as an example.

Supply Setting Function
Toner cartridge Draft Mode in the 

Advanced Settings tab
This check box allows the users to select a print mode 
that uses less toner. The image quality will be lower 
when this feature is used.

Print media Multiple-Up in the Layout 
tab

The printer prints two or more pages on one side of a 
sheet. Values for Multiple-Up are 2 Pages Up, 4 
Pages Up, 8 Pages Up, 16 Pages Up, 32 Pages Up. 
Combined with the duplex setting, Multiple-Up allows 
you to print up to 64 pages on one sheet of paper. (32 
images on the front and 32 on the back)
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Checking Page Counts
The total number of printed pages can be checked at the operator panel. Four meters are available: 
Meter 1, Meter 2, Meter 3, and Meter 4.
The Meter Readings counts the number of pages printed properly. Single side color print (including 
N-up) is counted as one job, and 2-sided print (including N-up) is counted as two. During 2-sided 
printing, if an error occurs after one side is printed properly, it is counted as one.
When printing color data, which has been converted by using ICC profile on an application, with the 
Color (Auto) setting, the data is printed by color even if it seems to be black and white data on the 
monitor. In that case, Meter 1 and Meter 4 are increased.
When doing 2-sided printing, a blank page may be inserted automatically depending on the settings of 
the application. In this case, the blank page is counted as one page.
For information about the individual meter, see "Meter Readings" on page 145.
Use the following procedure to check a meter:

1 Press the Menu button.

2 Select Meter Readings, and then press the  button.

3 Select the desired meter to check the number of pages.
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Moving the Printer
This section describes how to move the printer.

IMPORTANT: 
• Two people are required to move the printer.
• To prevent you from dropping the printer and getting backache or injuries, lift the printer by firmly gripping the 

recessed areas on both sides of the printer. Never lift the printer by gripping any other areas.

NOTE: 
• If the optional 250-sheet feeder has been installed, uninstall the optional 250-sheet feeder before moving the 

printer. If the optional 250-sheet feeder is not fixed securely to the printer, it may fall to the ground and cause 
injuries. For details on how to uninstall the optional 250-sheet feeder, see "Removing the Optional 250-Sheet 
Feeder" on page 288.

1 Turn off the printer and disconnect the power cord, interface cable, and any other cables.

2 Remove any paper in the output tray and slide the output tray extension inside the printer.

3 Pull the standard 250-sheet tray out of the printer about 200 mm. Hold the standard 250-sheet 
tray with both hands, and remove it from the printer.

o

4 Lift the printer and move it gently.

NOTE: 
• If you move the printer over a long distance, remove the toner cartridges from the printer to prevent toner from 

spilling, and pack the printer inside a box.
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5 Insert the standard 250-sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

6 Adjust the color registration before using your printer.

See also: 
• "Adjusting Color Registration" on page 227
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Removing Options
If the printer location needs to be changed or the printer and print media handling options need to be 
shipped to a new location, all print media handling options must be removed from the printer. For 
shipping, pack the printer and print media handling options securely to avoid damage.
This section includes:

• "Removing the Optional Memory Module" on page 286
• "Removing the Optional 250-Sheet Feeder" on page 288
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Removing the Optional Memory Module
1 Turn off the printer.

2 Turn the screw on the control board cover counterclockwise, and open the cover.

NOTE: 
• Loosen the screw. You do not need to remove the screw.

3 Push the clips on both sides of the slot outward.

4 Hold the memory module and pull it straight out.
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5 Close the control board cover, and turn the screw clockwise.

6 Turn on the printer.
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Removing the Optional 250-Sheet Feeder
1 Turn off the printer.

2 Disconnect the power cord from the power connector on the rear of the printer.

3 Pull the standard 250-sheet tray out of the printer about 200 mm. Hold the standard 250-sheet 
tray with both hands, and remove it from the printer.

4 Remove the two screws joining the printer and the optional 250-sheet feeder by unscrewing 
them with a coin or similar object.
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5 Gently lift the printer off the optional 250-sheet feeder, and place it on a level surface.

6 Insert the standard 250-sheet tray into the printer, and push until it stops.

7 Reconnect all cables into the rear of the printer and turn on the printer.

CAUTION:
• Two people are required to lift the printer.
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9
Contacting Fuji Xerox
This chapter includes:

• "Technical Support" on page 292
• "Online Services" on page 293
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Technical Support
Fuji Xerox recommends the Customer first utilize support materials shipped with the product, product 
diagnostics, information contained on the Web, and email support. If unsuccessful, to obtain service 
under product warranty the Customer must notify Fuji Xerox Telephone Support or its authorized 
service representative of the defect before the expiration of the warranty period. Customer will provide 
appropriate assistance to Telephone Support personnel to resolve issues, such as restoration of the 
operating system, software program and drivers to their default configuration and settings, verification 
of functionality of Fuji Xerox supplied products, replacement of customer replaceable units, clearing 
paper misfeeds and cleaning the unit and other prescribed routine and preventative maintenance.
If the Customer’s product contains features that enable Fuji Xerox or its authorised service 
representative to diagnose and repair problems with the product remotely, Fuji Xerox may request that 
the Customer allow such remote access to the product.
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Online Services
You can find detail Product and Consumable warranty information and activate your warranty by 
registering your details on our website at http://www.fujixerox.com/support/docuprint/
Fuji Xerox Online Support Assistant provides instructions and troubleshooting guides to resolve your 
printer problems. It is an easy-to-use, searchable online help. To find out more, please visit our online 
support at http://www.fujixerox.com/support/docuprint/

http://www.fujixerox.com/support/docuprint/
http://www.fujixerox.com/support/docuprint/
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